Thanks to Heather Jagman for her love, support, and encouragement.

—Arek Dreyer

Thanks to Dr. Nasser Hanna and the amazing staff at Indiana University Health. I would never have been able to embark on this journey without them.

This book is dedicated to my children, who are the best thing to ever happen to me.

—Adam Karneboge
Acknowledgments  Thank you, dear reader, for staying on top of what’s new, while keeping your users’ needs as the root of what you do.

Thanks to Tim Cook and everyone at Apple for always innovating. Thank you to Susan Najour and the Technical Training and Certification group for help and direction.

Thank you to Steve Leebve for insightful technical editing.

Thanks to Craig Cohen for technical assistance.

Thank you to the amazingly capable Nancy Davis and Victor Gavenda for gently making sure these materials made it into your hands, and to Liz Welch, Scout Festa, and to Maureen Forys and her team at Happenstance Type-O-Rama for working their editorial and production magic.

Thanks to Ron Ledwich, Thomas Montgomery, Schoun Regan, Steven Vogt, and Eric Zelenka at Apple for specific help.

Thanks to the people who generously provided feedback and assistance, including:

Mike Boylan   Richard Goon   Keith Mitnick
Sandy Brenner  Steve Hayman  Tim O’Boyle
Armin Briegel  Kelsey Janetski  Vernon Rooze
Jon Clough  Andrew Johnson  Alby Rose
Maria Coniglio  Samuel Keeley  Joe Schuepach
Christos Drosos  Mike Kole  Chris Smalstig
Charles Edge  Andre LaBranche  Jon Synowiec
Dave Hale  Ben Levy  Rich Trouton

Thank you to Kevin White and Gordon Davisson, coauthors of the previous version of this guide.

—The authors
Contents at a Glance

About This Guide ................................................. xv

Installation and Configuration
Lesson 1  Introduction to macOS ................................. 3
Lesson 2  Update, Upgrade, or Reinstall macOS ................ 9
Lesson 3  Set Up and Configure macOS ...................... 37
Lesson 4  Use the Command-Line Interface .................... 83
Lesson 5  Use macOS Recovery ................................ 109
Lesson 6  Update macOS ........................................ 127

User Accounts
Lesson 7  Manage User Accounts ............................... 145
Lesson 8  Manage User Home Folders ......................... 179
Lesson 9  Manage Security and Privacy ......................... 197
Lesson 10 Manage Password Changes .......................... 231

File Systems
Lesson 11 Manage File Systems and Storage ................. 257
Lesson 12 Manage FileVault .................................. 293
Lesson 13 Manage Permissions and Sharing ................ 307
Lesson 14 Use Hidden Items, Shortcuts, and File Archives .... 333

Data Management
Lesson 15 Manage System Resources ......................... 355
Lesson 16 Use Metadata, Spotlight, and Siri ................. 373
Lesson 17 Manage Time Machine ............................... 395
Applications and Processes
Lesson 18  Install Apps .................................................. 417
Lesson 19  Manage Documents ........................................ 455
Lesson 20  Manage and Troubleshoot Apps ....................... 507

Network Configuration
Lesson 21  Manage Basic Network Settings ....................... 547
Lesson 22  Manage Advanced Network Settings ................. 567
Lesson 23  Troubleshoot Network Issues ......................... 617

Network Services
Lesson 24  Manage Network Services ............................. 639
Lesson 25  Manage Host Sharing and Personal Firewall .......... 693

System Management
Lesson 26  Troubleshoot Peripherals ............................... 737
Lesson 27  Manage Printers and Scanners ......................... 757
Lesson 28  Troubleshoot Startup and System Issues .......... 795

Index ........................................................................... 827
# Table of Contents

About This Guide ................................................. xv

## Installation and Configuration

**Lesson 1**
- Introduction to macOS ......................................... 3
- macOS High Sierra 10.13 ....................................... 3
- What's New in macOS High Sierra .......................... 5
- macOS History .................................................. 7

**Lesson 2**
- Update, Upgrade, or Reinstall macOS ....................... 9
- macOS Installation Methods ................................... 9
- Prepare to Upgrade or Reinstall macOS .................... 11
- Upgrade or Install macOS .................................... 15
- Troubleshoot Installation Issues .............................. 20
- Exercise 2.1 Prepare a Mac for Upgrade .................... 21
- Exercise 2.2 Upgrade to macOS High Sierra ................ 25
- Exercise 2.3 Erase a Mac and Install macOS High Sierra ... 29
- Exercise 2.4 Verify That macOS Is Installed Correctly ... 35

**Lesson 3**
- Set Up and Configure macOS ................................. 37
- Configure a New Mac ........................................... 37
- Manage System Settings ....................................... 48
- Inspect System Information ................................... 52
- Exercise 3.1 Configure a New Mac for Exercises .......... 56
- Exercise 3.2 Configure an Existing Mac for Exercises ... 60
- Exercise 3.3 Configure System Preferences ................ 63
| Exercise 3.4 | Download Participant Materials for Classroom Use | 69 |
| Exercise 3.5 | Download Participant Materials for Independent Study | 72 |
| Exercise 3.6 | Install a Configuration Profile | 76 |
| Exercise 3.7 | Examine System Information | 78 |

| Lesson 4 | Use the Command-Line Interface | 83 |
| Reference 4.1 | Command-Line Basics | 83 |
| Reference 4.2 | CLI Navigation | 87 |
| Reference 4.3 | Manipulate Files in the CLI | 91 |
| Reference 4.4 | Manage macOS from the CLI | 95 |
| Reference 4.5 | Command-Line Tips and Tricks | 96 |
| Exercise 4.1 | Command-Line Navigation | 97 |
| Exercise 4.2 | Manage Files and Folders with Commands | 102 |

| Lesson 5 | Use macOS Recovery | 109 |
| Reference 5.1 | Start Up from macOS Recovery | 109 |
| Reference 5.2 | macOS Recovery Utilities | 111 |
| Reference 5.3 | Create a macOS Recovery Disk | 113 |
| Exercise 5.1 | Use macOS Recovery | 114 |
| Exercise 5.2 | Create a macOS Install Disk | 119 |

| Lesson 6 | Update macOS | 127 |
| Reference 6.1 | Automatic Software Updates | 127 |
| Reference 6.2 | Manually Install Updates | 134 |
| Reference 6.3 | Examine Installation History | 134 |
| Exercise 6.1 | Manually Install Software Updates | 135 |
| Exercise 6.2 | Manually Install Software Updates Independently | 136 |
| Exercise 6.3 | Use Automatic Software Update | 138 |

| User Accounts |

| Lesson 7 | Manage User Accounts | 145 |
| Reference 7.1 | User Accounts | 145 |
| Reference 7.2 | Configure User Accounts | 152 |
| Reference 7.3 | Restrict Local User Access | 157 |
| Reference 7.4 | Configure Login and Fast User Switching | 158 |
Exercise 7.1  Create a Standard User Account ............................................. 163
Exercise 7.2  Create a Managed User Account Using Parental Controls ... 172

Lesson 8  Manage User Home Folders ................................. 179
Reference 8.1  User Home Folders ......................................................... 179
Reference 8.2  Delete User Accounts and Archive
Their Home Folder Contents ............................................................ 182
Reference 8.3  Migrate and Restore Home Folders ......................... 183
Exercise 8.1  Restore a Deleted User Account .......................... 186

Lesson 9  Manage Security and Privacy ................................. 197
Reference 9.1  Password Security .......................................................... 197
Reference 9.2  Manage Secrets in Keychain ................................. 200
Reference 9.3  Use iCloud Keychain ......................................................... 203
Reference 9.4  Manage System Security ................................................. 206
Reference 9.5  Manage User Privacy .......................................................... 211
Reference 9.6  Approve Kernel Extensions ............................................ 218
Reference 9.7  Lock Your Screen ............................................................. 220
Exercise 9.1  Manage Keychains ................................................. 221

Lesson 10  Manage Password Changes ................................. 231
Reference 10.1  Change Known Passwords ................................. 231
Reference 10.2  Reset Lost Passwords ................................................. 232
Reference 10.3  Manage User Keychains ............................................. 236
Reference 10.4  Secure Mac Startup ......................................................... 240
Exercise 10.1  Reset Account Passwords in macOS Recovery ............. 241
Exercise 10.2  Reset Account Passwords ............................................. 243
Exercise 10.3  Observe Automatic Login Keychain Creation ............. 246
Exercise 10.4  Set a Firmware Password ............................................. 252

File Systems

Lesson 11  Manage File Systems and Storage ............................... 257
Reference 11.1  File Systems ................................................................. 257
Reference 11.2  Mount, Unmount, and Eject Disks ......................... 263
Reference 11.3  Inspect File System Components ............................... 266
Reference 11.4  Manage File Systems ...................................................... 270
Reference 11.5  Troubleshoot File Systems ............................................ 275
<table>
<thead>
<tr>
<th>Exercise 11.1</th>
<th>View Disk and Volume Information</th>
<th>279</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exercise 11.2</td>
<td>Erase a Disk</td>
<td>283</td>
</tr>
<tr>
<td>Exercise 11.3</td>
<td>Repair Partitions and Volumes in Target Disk Mode</td>
<td>286</td>
</tr>
<tr>
<td>Exercise 11.4</td>
<td>Repair Partitions and Volumes in Recovery Mode</td>
<td>291</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Lesson 12</th>
<th>Manage FileVault</th>
<th>293</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference 12.1</td>
<td>FileVault Introduction</td>
<td>293</td>
</tr>
<tr>
<td>Reference 12.2</td>
<td>Enable FileVault</td>
<td>294</td>
</tr>
<tr>
<td>Exercise 12.1</td>
<td>Turn On FileVault</td>
<td>298</td>
</tr>
<tr>
<td>Exercise 12.2</td>
<td>Restart a FileVault-Protected Mac</td>
<td>300</td>
</tr>
<tr>
<td>Exercise 12.3</td>
<td>Use a FileVault Recovery Key</td>
<td>302</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Lesson 13</th>
<th>Manage Permissions and Sharing</th>
<th>307</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference 13.1</td>
<td>File-System Permissions</td>
<td>307</td>
</tr>
<tr>
<td>Reference 13.2</td>
<td>Examine Permissions for Sharing</td>
<td>313</td>
</tr>
<tr>
<td>Reference 13.3</td>
<td>Manage Permissions</td>
<td>318</td>
</tr>
<tr>
<td>Exercise 13.1</td>
<td>Create Items with Default Permissions</td>
<td>323</td>
</tr>
<tr>
<td>Exercise 13.2</td>
<td>Test Permissions Changes</td>
<td>328</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Lesson 14</th>
<th>Use Hidden Items, Shortcuts, and File Archives</th>
<th>333</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference 14.1</td>
<td>Examine Hidden Items</td>
<td>333</td>
</tr>
<tr>
<td>Reference 14.2</td>
<td>Examine Packages</td>
<td>336</td>
</tr>
<tr>
<td>Reference 14.3</td>
<td>Use File-System Shortcuts</td>
<td>338</td>
</tr>
<tr>
<td>Reference 14.4</td>
<td>Use File Archives</td>
<td>343</td>
</tr>
<tr>
<td>Exercise 14.1</td>
<td>Navigate Hidden Items</td>
<td>349</td>
</tr>
</tbody>
</table>

**Data Management**

<table>
<thead>
<tr>
<th>Lesson 15</th>
<th>Manage System Resources</th>
<th>355</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference 15.1</td>
<td>macOS File Resources</td>
<td>355</td>
</tr>
<tr>
<td>Reference 15.2</td>
<td>System Integrity Protection</td>
<td>361</td>
</tr>
<tr>
<td>Reference 15.3</td>
<td>Manage Font Resources</td>
<td>362</td>
</tr>
<tr>
<td>Exercise 15.1</td>
<td>Manage Font Resources</td>
<td>363</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Lesson 16</th>
<th>Use Metadata, Spotlight, and Siri</th>
<th>373</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference 16.1</td>
<td>File-System Metadata</td>
<td>373</td>
</tr>
<tr>
<td>Reference 16.2</td>
<td>Spotlight and Siri</td>
<td>377</td>
</tr>
<tr>
<td>Exercise 16.1</td>
<td>Examine File Metadata</td>
<td>389</td>
</tr>
</tbody>
</table>
**Lesson 17**  Manage Time Machine .......................... 395  
Reference 17.1  Time Machine .......................... 395  
Reference 17.2  Configure Time Machine .................. 400  
Reference 17.3  Restore from Time Machine ................. 402  
Exercise 17.1  Configure Time Machine .................. 405  
Exercise 17.2  Restore Using Time Machine ................. 409

**Applications and Processes**

**Lesson 18**  Install Apps .......................... 417  
Reference 18.1  Install an App from the App Store ............ 417  
Reference 18.2  App Security .......................... 427  
Reference 18.3  Install Apps Using Software Packages and Drag-and-Drop .................. 433  
Reference 18.4  Remove Installed Software ................. 435  
Exercise 18.1  Install an App from the App Store ............ 436  
Exercise 18.2  Use an Installer Package .................. 444  
Exercise 18.3  Drag and Drop to Install an App ............... 448  
Exercise 18.4  Remove Apps .......................... 451

**Lesson 19**  Manage Documents .................. 455  
Reference 19.1  Open Documents .......................... 455  
Reference 19.2  Save Documents .......................... 463  
Reference 19.3  Manage Automatic Resume .................. 473  
Reference 19.4  Store Documents in iCloud ................. 475  
Reference 19.5  Optimize Local Storage .................. 484  
Exercise 19.1  Use Alternate Apps .......................... 487  
Exercise 19.2  Practice Auto Save and Versions ............... 492  
Exercise 19.3  Manage Document Locking .................. 496  
Exercise 19.4  Store Documents in iCloud ................. 498

**Lesson 20**  Manage and Troubleshoot Apps ............... 507 
Reference 20.1  Apps and Processes .................. 507  
Reference 20.2  Manage App Extensions .................. 510  
Reference 20.3  Monitor Apps and Processes ................. 515  
Reference 20.4  Troubleshoot Apps .................. 519  
Exercise 20.1  Force Apps to Quit .................. 529  
Exercise 20.2  Troubleshoot Preferences .................. 535  
Exercise 20.3  Examine App Diagnostics .................. 540
Network Configuration

Lesson 21  Manage Basic Network Settings ................. 547
Reference 21.1 Network Terminology ........................ 547
Reference 21.2 Network Activity .............................. 550
Reference 21.3 Configure Basic Network Settings .......... 553
Exercise 21.1 Connect to a Wi-Fi Network .................... 561
Exercise 21.2 Monitor Network Connectivity ................. 564

Lesson 22  Manage Advanced Network Settings .......... 567
Reference 22.1 Manage Network Locations .................. 567
Reference 22.2 Network Interfaces and Protocols .......... 570
Reference 22.3 Manage Network Service Interfaces ......... 574
Reference 22.4 Configure VPN Settings ....................... 578
Reference 22.5 Configure Advanced Network Settings .... 583
Exercise 22.1 Configure Network Locations .................. 594
Exercise 22.2 Configure Network Service Order ............. 601
Exercise 22.3 Configure VPN Settings ......................... 606
Exercise 22.4 Advanced Wi-Fi Configuration ................. 610

Lesson 23  Troubleshoot Network Issues ................. 617
Reference 23.1 Troubleshoot General Network Issues ....... 617
Reference 23.2 Use Network Utility to Troubleshoot Network Issues 622
Exercise 23.1 Troubleshoot Network Connectivity .......... 627

Network Services

Lesson 24  Manage Network Services ..................... 639
Reference 24.1 Network Services ............................. 639
Reference 24.2 Configure Network Service Apps ........... 643
Reference 24.3 Connect to File-Sharing Services .......... 657
Reference 24.4 Troubleshoot Network Services ............. 667
Exercise 24.1 Configure a Network Service Account ....... 673
Exercise 24.2 Use File-Sharing Services ...................... 682
Exercise 24.3 Troubleshoot Network Services ............... 687
Lesson 25  Manage Host Sharing and Personal Firewall . . . 693
Reference 25.1 Enable Host-Sharing Services ....................... 693
Reference 25.2 Control Remote Computers ........................ 702
Reference 25.3 Share Files with AirDrop ............................ 711
Reference 25.4 Manage the Personal Firewall .................... 714
Reference 25.5 Troubleshoot Shared Services .................... 719
Exercise 25.1 Use Host-Sharing Services .......................... 721
Exercise 25.2 Configure a Personal Firewall ...................... 727

System Management

Lesson 26  Troubleshoot Peripherals ................................. 737
Reference 26.1 Peripheral Technologies ............................ 737
Reference 26.2 Manage Bluetooth Devices ....................... 744
Reference 26.3 Troubleshoot Peripheral Issues .................. 748
Exercise 26.1 Examine Peripherals Using System Information .... 752

Lesson 27  Manage Printers and Scanners ............................ 757
Reference 27.1 Printing in macOS ................................. 757
Reference 27.2 Configure Printers and Scanners ................. 759
Reference 27.3 Manage Print Jobs .................................. 769
Reference 27.4 Troubleshoot Print Issues ......................... 777
Exercise 27.1 Configure Printing ................................. 778
Exercise 27.2 Manage Printing .................................. 785
Exercise 27.3 Troubleshoot Printing ........................... 791

Lesson 28  Troubleshoot Startup and System Issues ............... 795
Reference 28.1 System Initialization ............................ 795
Reference 28.2 User Sessions .................................. 802
Reference 28.3 Sleep Modes, Logout, and Shutdown ............ 804
Reference 28.4 Use Startup Shortcuts .......................... 810
Reference 28.5 Troubleshoot System Initialization ............. 813
Reference 28.6 Troubleshoot User Sessions ..................... 816
Exercise 28.1 Examine System Startup .......................... 817
Exercise 28.2 Use Startup Modes .............................. 818
Exercise 28.3 Use Safe Mode .................................. 824

Index .................................................. 827
About This Guide


Audience

Whether you’re an experienced system administrator or you just want to dig deeper into macOS, you’ll learn what ACSPs do to update, upgrade, reinstall, configure, maintain, diagnose, and troubleshoot macOS High Sierra.

You should be comfortable using a Mac before you read this guide or take the course. If you’re not sure about basic Mac use, visit “Get to know your new Mac” at support.apple.com/explore/new-to-mac.

How to Use the Guide

Use the reference sections to get familiar with macOS High Sierra. Then use the exercises to practice what you’ve learned. After you’ve completed the guide, you should be able to:

▶ Explain how macOS High Sierra works
▶ Explain the best practices for updating, upgrading, reinstalling, configuring, and using macOS High Sierra
▶ Explain macOS High Sierra troubleshooting and repair procedures
▶ Use appropriate tools and techniques in macOS High Sierra to diagnose and resolve issues
Reference Sections
Unless otherwise specified, references to macOS in this guide refer to macOS High Sierra 10.13.0. As Apple updates macOS High Sierra, this guide might also be updated. Updates are delivered to you through the Web Edition, which contains the complete guide, including updates. When you purchase this guide from Peachpit (in any format), you automatically get access to its Web Edition.

If you bought an eBook from peachpit.com, your Web Edition will appear under the Digital Purchases tab on your Account page. If you bought an eBook from a different vendor or you bought a print book, you must register your purchase on peachpit.com to access the online content:

2. Sign in or create a new account.
4. Answer the questions as proof of purchase.
   The Web Edition appears under the Digital Purchases tab on your Account page.
5. Click the Launch link to access the Web Edition.
6. Get supporting exercise files under the Registered Products tab on your Account page:
   Click the Access Bonus Content link below the title of your product to go to the download page, then click the lesson file links to download the supporting exercise files.

Exercises
For the most part, the exercises in this guide work in the classroom or at home. If you’re learning from home, use a Mac that isn’t critical to your daily productivity because exercises might disrupt your Mac. To complete the exercises, ensure you have the following:

- A Mac that meets the requirements to install macOS High Sierra
- macOS High Sierra (see Exercise 2.2, “Upgrade to macOS High Sierra”)
- A high-speed Internet connection
Exercise files (see Exercise 3.5, “Download Participant Materials for Independent Study”)

An Apple ID (you don’t need to provide credit card information to get free apps from the App Store)

You don’t have to have these items, but they can be helpful:

An iCloud account.

An erasable external storage disk with a capacity of at least 12 GB for Exercise 5.2, “Create a macOS Install Disk.”

An isolated network or subnet. You can use a small network Wi-Fi router with multiple Ethernet ports—for example, Apple AirPort Extreme (www.apple.com/airport-extreme/).

At least two Wi-Fi networks (one should be visible).

A second Mac running macOS High Sierra. This Mac can have macOS Server 5.4 or later installed and set up with an exercise-specific configuration.

The required Thunderbolt, USB-C or FireWire cable to connect two Mac computers in target disk mode.

A Mac with all-flash storage.

Additional Materials

Apple Support
The Apple Support website (https://support.apple.com) includes the latest free online Apple Support articles.

Apple Course
Participants use this guide in the macOS Support Essentials 10.13 course. Apple Certified Trainers teach each course and give presentations and demonstrations. Participants practice macOS support with hands-on exercises. The course prepares you for the macOS Support Essentials 10.13 exam.

ACSP 10.13 Certification
An ACSP 10.13 certification verifies that you understand macOS core functionality and can configure key services, troubleshoot, and support users. If you pass the
macOS Support Essentials 10.13 exam, you are eligible for an ACSP 10.13 certification. Apple macOS certifications are for IT professionals who:

- Want to know how to add a Mac to a Windows or other standards-based network
- Support macOS users
- Manage networks of Mac computers; for example, a system administrator at a large organization, a technology specialist who manages computer labs, or a teacher who manages classroom networks
- Manage complex, multiplatform networks that include Mac computers

Apple certification exams are delivered at Apple Authorized Training Provider locations. Visit http://locate.apple.com/ to find a location. To learn more about Apple certifications and to find the macOS Support Essentials 10.13 Exam Prep Guide, visit http://training.apple.com. To prepare for the macOS Support Essentials 10.13 exam, do the following:

- Read the reference sections of this guide.
- Complete the exercises in this guide.
- Complete the macOS Support Essentials 10.13 course.
- Gain experience on a Mac running macOS High Sierra.
- Study the macOS Support Essentials 10.13 Exam Preparation Guide.
Lesson 4

Use the Command-Line Interface

Use the command-line interface (CLI) to access additional administrative functionality.

Reference 4.1
Command-Line Basics

The CLI includes these advantages:

- Additional administrative and troubleshooting options are available from CLI. For example, the following apps have CLI equivalents that include additional options: System Information (system_profiler), Installer (installer), Software Update (softwareupdate), Disk Utility (diskutil), and Spotlight (mdfind). These are just a few instances, as nearly every administrative function has both a graphical and a command-line tool.

- From the CLI you have more access to the file system. For example, the Finder hides many files and folders that are visible in the CLI. Also, there are many file-system permissions settings that the Finder doesn’t display.

- You can remotely log in to a Mac computer’s CLI using the Secure Shell (SSH) protocol. This remote access allows administrators to make changes at the command line without alerting the user to their work.

- By using the sudo command, any administrator can run commands as the system administrator user, also known as root. This enables great administrative flexibility in the CLI.

GOALS

- Be able to describe when the command-line interface is useful
- Explore Terminal
If you are comfortable with the CLI syntax, you can apply it to a command-line script. This enables you to automate repetitive tasks.

If you combine CLI instructions with Apple Remote Desktop (ARD), you can remotely administer multiple, even thousands of, Mac computers simultaneously. ARD enables you to remotely send the same command to many Mac computers with one click. For more information about Apple Remote Desktop go to https://www.apple.com/remotedesktop.

Access the CLI
A shell is the first command that runs when you access the CLI. It displays the CLI. You can access the CLI several ways:

You can use Terminal. It's in /Applications/Utilities/Terminal. Terminal is a customizable interface. It includes a tabbed interface for multiple command-line sessions, multiple split panes for viewing history, support for full-screen mode, and Touch Bar shortcuts.

At startup, press and hold Command-S to start a Mac in single-user mode. This mode starts the minimum system required to provide you with a command-line prompt so that you can enter commands to repair a Mac that can't fully start up. Read more about single-user mode in Lesson 28, “Troubleshoot Startup and System Issues.”
SSH remote login enables you to securely log in from a remote computer to access your Mac computer’s command line. SSH is a common standard, so you can use any operating system that supports SSH to remotely log in to your Mac.

**Work in the Command Line**

The first thing you’ll see at the command line is the prompt. The prompt indicates that you can enter a command. By default, the prompt shows you the name of the Mac you’re using, followed by where you are in the file system, followed by your current user account name, and ending with a $. The $ at the end of the prompt indicates that you’re using the standard Bash shell. Where you are in the computer’s file system is called the working directory, and it changes as you navigate through the file system.

At the prompt you enter your command string, often more than one word, and press Return to initiate or execute the command. An executing command will take over the Terminal window with a text interface, show the results of the command and return to the prompt, or perform some work and return to the prompt when complete. Many commands display results only if a problem occurs. Read what the command returns to make sure it doesn’t indicate a problem.

Some commands take time to execute and may not give a progress indication. If you don’t see a new prompt, generally assume your last command is still running.
### Command String

The command string includes a few parts:

```
ls  -lRA ~/Documents > list.txt
```

<table>
<thead>
<tr>
<th></th>
<th>Command Name</th>
<th>Argument</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>In this example the &quot;ls&quot; command displays a list of a folder's contents</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Options add conditions, limits, or other modifiers to the command</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>This is the recipient of the action, often specified as a file or folder path</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Redirected output, or other commands, as needed... In this example a text file is created from the list output</td>
<td></td>
</tr>
</tbody>
</table>

- **Command name (1)**—Some commands just need you to enter their name to execute.
- **Command options (2)**—After a command name, you might specify options (or flags) that change a command's default behavior. Options aren't required and can be different for every command. Options start with one or two dashes to distinguish them from arguments. Many commands can include several single-letter options after a single dash. For example, `ls -lA` is the same as `ls -l -A`.
- **Arguments (3)**—After the command and its options, you typically specify an argument (or parameter), which is the item you want the command to modify. An argument is needed only if the command requires an item to act upon.
- **Extras (4)**—Extras aren't necessary, but they can enhance the capabilities of a command. For example, you could add items that redirect the command output, include other commands, or generate a document.

### Command-Line Example

Here is an example in which the user Joan works on a Mac called MyMac and her working directory is Documents. She deletes an app called Junk inside the /Applications folder. Joan presses Return after she enters her command.
In this example the command was entered and executed properly, and macOS returns to a new prompt. This is an example of a command that returns information only if it didn’t execute properly. The Mac will usually let you know if you entered something incorrectly by returning an error message or help text. macOS won't prevent or warn you from entering a destructive command, such as accidentally deleting your home folder. Always double-check your typing.

**Use Manual (man) Pages**
When you want to learn more about a command, you enter `man` followed by the name of the command. Manual (man) pages include detailed information about commands and references to other commands. After you open a man page, use navigation shortcuts to move through it:

- Use the Up Arrow and Down Arrow keys to scroll.
- Use the Space bar to move down one screen at a time.
- Enter a slash (/) and a keyword to search through a man page.
- Exit the man page by pressing Q.

If you don't know the name of the command you're looking for, enter `man -k` and a keyword to search the database. For example, you enter `man -k owner` to return a short list of commands used for changing file and folder ownership, including the command `chown`.

Enter the `apropos` command and a search term like `network`, and commands that are related to `network` are displayed.

**Reference 4.2  CLI Navigation**
The command line is case-sensitive and requires that you use full filenames with filename extensions. For example, the CLI won't locate the “itunes” app, but it will locate the “iTunes.app” app.

A path represents a file or folder's location in the file system. For instance, Disk Utility's file system path is `/Applications/Utilities/Disk Utility.app`. In the CLI, you use the path-name to navigate through the file system and to identify the location of items.
There are two types of file-system pathnames:

- **Absolute** pathnames are full descriptions of an item location, starting from the root (or beginning) of the system (startup) volume. An absolute path begins with a forward slash (/) to indicate the beginning of the file system. An example of the absolute path to the user Joan's Drop Box folder is `/Users/joan/Public/Drop Box`, which means: Start from the startup volume; go to the Users folder, then to the joan subfolder, and then to the Public subfolder; and select the item named Drop Box.

- **Relative** paths are partial descriptions of an item location. They’re based on where you’re currently working in the file system. When you first open Terminal, your session starts at your home folder. The relative path from your home folder to your Drop Box is `Public/Drop Box`. This means: From where you are now, go into the Public subfolder, and select the item named Drop Box.

### Navigate with Commands

You use three commands to navigate the file system: `pwd`, `ls`, and `cd`. Short for “print working directory,” `pwd` reports the absolute path of your current working location:

```
MyMac:~ joan$ pwd
/Users/joan
```

Short for “list,” `ls` lists the folder contents of your current working location. Enter a pathname following the `ls` command to list the contents of the specified item. The `ls` command has additional options for listing file and folder information that are covered throughout this lesson.

```
MyMac:~ joan$ ls
```

Short for “change directory,” `cd` is the command you use to navigate. Enter a pathname following the `cd` command to change your current working location to the specified folder. Entering `cd` without specifying a path returns you to your home folder.

```
MyMac:~ joan$ cd
```

### Use Special Characters

You can use special characters at the prompt or in pathnames to save time and to be able to use special characters in filenames and pathnames.

Enter a space between command items to separate the items. If you don’t want the space character to separate items, use the backslash (\) before a space character.

```
MyMac:~ joan$ cd Public/Drop\ Box
```

```
MyMac:Drop Box joan$ pwd
/Users/joan/Public/Drop Box
```
Another way to enter filenames and paths with spaces is to surround filenames and paths with quotation marks:

```
MyMac:~ joan$ cd "Public/Drop Box"
MyMac:Drop Box joan$ pwd
/Users/joan/Public/Drop Box
```

You can drag and drop items from the Finder to Terminal. When you do this, Terminal enters an item’s absolute path with the appropriate backslash characters before spaces in names. Use the Tab key completion feature that’s built into the command line to automatically complete filenames and pathnames.

Other special characters include !, $, &, *, ;, |, \, parentheses, quotes, and brackets. The Finder drag-and-drop and Tab key completion parse these characters. In the CLI you can enter a backslash before any special character to treat that special character as regular text rather than as a special character.

Use double periods (..) to indicate a parent folder. For example, if you are in your home folder at /Users/username, enter cd .. to navigate to the /Users folder.

Use the tilde (~) to indicate the current user home folder in a pathname. For example, say the current user’s Drop Box is in ~/Public/. Use the tilde to specify another user’s home folder. For example, ~jill/Public specifies Jill’s Public folder.

**Use Tab Key Completion**

Use Tab key completion to automatically complete filenames, pathnames, and command names. Tab key completion prevents you from making typos and verifies that the item you’re entering exists.

Here’s an example of Tab key completion. Start from your home folder by entering cd, then P, and then press the Tab key. The Terminal window will flash quickly and you may hear an audible alert, letting you know there is more than one choice for items that begin with “P” in your home folder. Press the Tab key again, and the Mac will display your two choices, Pictures and Public. Now, enter u after the initial P, and then press the Tab key again, and the Mac will automatically finish Public/ for you. Finally, enter D and press the Tab key one last time, and the computer will finish the path with Public/Drop\ Box/.

When completing a folder name, Tab key completion puts a forward slash (/) at the end. It assumes that you want to continue the path. Most commands ignore the trailing slash, but a few behave differently if it’s there. You should delete the / at the end of a path.
Tab key completion reads only into folders you have permission to access. You might run into issues trying to use this feature for items that are readable only by a root user.

**View Invisible Items**
The CLI and the Finder hide many files and folders from view. The hidden items are often macOS support items. In the Finder, these items are set with a hidden file flag. The CLI ignores the hidden file flag and shows most hidden items. If you enter the `ls` command, you won't see filenames that begin with a period. To see hidden items in long format at the command line, add the `-a` option to the `-l` option when you enter the `ls` command:

```
MyMac:~ joan$ ls -la
```

```
total 16
 drwxr-xr-x+ 14 ladmin staff 448 Oct 26 01:06 .
 drwxr-xr-x  5 root admin 160 Oct 26 00:54 ..
-r--------  1 ladmin staff  7 Oct 26 00:54 .CFUserTextEncoding
 drwx-------  5 ladmin staff 160 Oct 26 01:06 .Trash
-rw-------  1 ladmin staff 139 Oct 26 01:06 .bash_history
 drwx-------  6 ladmin staff 192 Oct 26 11:29 .bash_sessions
 drwx------+ 4 ladmin staff 128 Oct 26 01:06 Desktop
 drwx------+ 3 ladmin staff  96 Oct 26 00:54 Documents
 drwx------+ 3 ladmin staff  96 Oct 26 00:54 Downloads
 drwx------@  54 ladmin staff 1728 Oct 26 09:17 Library
 drwx------+ 3 ladmin staff  96 Oct 26 00:54 Movies
 drwx------+ 3 ladmin staff  96 Oct 26 00:54 Music
 drwx------+ 3 ladmin staff  96 Oct 26 00:54 Pictures
 drwxr-xr-x+ 4 ladmin staff 128 Oct 26 00:54 Public
```

Any item with a period at the beginning of its name is hidden by default in the CLI and the Finder. These items are created and used by macOS. Leave them alone.

**Navigate to Other Volumes**
In the CLI, the system volume is also known as the root volume, and it's identified by a lone forward slash. Other nonroot volumes appear as part of the main file system in the Volumes folder.
Use Marks and Bookmarks
Add marks and bookmarks as you work; then use them to quickly navigate through lengthy Terminal output.

Select a line in Terminal, then choose Edit > Marks > Mark to add a mark. By default, Mark > Automatically Mark Prompt Lines is selected, so each prompt line sets a mark. Then you can choose Edit > Select Between Marks, or choose Edit > Navigate > Jump to Previous Mark, or just press Command-Up Arrow.

Choose Edit > Marks > Mark as Bookmark to add a bookmark. Then choose Edit > Bookmarks to see a list of bookmarks. Choose a bookmark to jump to that bookmark.

Reference 4.3
Manipulate Files in the CLI
When you manage and edit files in the CLI, you have more options—and more chances to make mistakes.

File Examination Commands
Use the cat, less, file, and find commands to locate and examine files. Read the man pages for these commands to find out more about them.

Short for concatenate, the cat command displays a file sequentially to Terminal. The syntax is cat, followed by the path to the item you want to view. Use the cat command to append to text files using the >> redirect operator. In the following example, Joan uses the cat command to view the content of two text files in her Desktop folder, TextDocOne.txt and TextDocTwo.txt. Then she uses the cat command with the >> redirect operator to append the second text file to the end of the first text file.

```
MyMac:~ joan$ cat Desktop/TextDocOne.txt
This is the content of the first plain text document.
MyMac:~ joan$ cat Desktop/TextDocTwo.txt
This is the content of the second plain text document.
MyMac:~ joan$ cat Desktop/TextDocTwo.txt >> Desktop/TextDocOne.txt
MyMac:~ joan$ cat Desktop/TextDocOne.txt
This is the content of the first plain text document.
This is the content of the second plain text document.
```
Use the `less` command to view long text files. It enables you to browse and search the text. Enter `less`, followed by the path to the item you want to view. The `less` interface is the same interface you use to view man pages, so the navigation shortcuts are the same.

The `file` command determines a file type based on its content. This is useful for identifying files that don’t have a filename extension. The syntax is `file` followed by the path to the file you’re trying to identify. In the following example, Joan uses the `file` command to locate the file type of two documents in her Desktop folder: PictureDocument and TextDocument:

```
MyMac:~ joan$ ls Desktop/
PictureDocument.tiff TextDocument.txt
MyMac:~ joan$ file Desktop/PictureDocument.tiff
Desktop/PictureDocument.tiff: TIFF image data, big-endian
MyMac:~ joan$ file Desktop/TextDocument.txt
Desktop/TextDocument.txt: ASCII English text
```

Use the `find` command to locate items based on search criteria. The `find` command doesn’t use Spotlight, but it does enable you to set search criteria and use filename wildcards. (Filename wildcards are covered in the next section.) The syntax is `find`, followed by the beginning path of the search, then an option defining your search criteria, and then the search criteria within quotation marks. In the following example, Joan uses the `find` command to locate picture files in her home folder by searching only for files with names that end in `.tiff`:

```
MyMac:~ joan$ find /Users/joan -name "*.tiff"
/Users/joan/Desktop/PictureDocument.tiff
/Users/joan/Pictures/FamilyPict.tiff
/Users/joan/Pictures/MyPhoto.tiff
```

When you use the `find` command to start a search at the root of the system drive, you should also use the `-x` option to avoid searching the `/Volumes` folder.

To use Spotlight from the command line, enter the `mdfind` command. The syntax is `mdfind` followed by your search criteria.
Use Wildcard Characters

You can use wildcard characters to define pathname and search criteria. Here are three of the most common wildcards:

- Use the asterisk (*) wildcard to match any string of characters. For instance, entering * matches all files, and entering *.tiff matches all files that end in .tiff.
- Use the question mark (?) wildcard to match a single character. For example, entering b?ok matches book but not brook.
- Use square brackets ([ ]) to define a range of characters. For example, [Dd]ocument locates items named Document or document, and doc[1-9] matches files named doc#, where # is a number between 1 and 9.

You can combine filename wildcards. Consider a collection of five files with the names ReadMe.rtf, ReadMe.txt, read.rtf, read.txt, and It’s All About Me.rtf. Using wildcards to specify these files:

- *.rtf matches ReadMe.rtf, read.rtf, and It’s All About Me.rtf
- ???.* matches read.rtf and read.txt
- [Rr].rtf matches ReadMe.rtf and read.rtf
- [A-Z].* matches ReadMe.rtf, ReadMe.txt, and It’s All About Me.rtf

Use Recursive Commands

When you direct a command to execute a task on an item, it touches only the item you specify. If the item you specify is a folder, the command won’t navigate inside the folder to execute the command on the enclosed items. If you want a command to execute on a folder and its contents, you must tell the command to run recursively. Recursive means “Execute the task on every item inside every folder starting from the path I specify.” Many commands accept -r or -R as the option to indicate that you want the command to run recursively.

In the following example, Joan lists the contents of her Public folder normally, and then recursively using the -R option. When she lists the contents of the Public folder recursively, macOS lists the contents of the Drop Box and Drop Folder:

```
Mymac:~ joan$ ls Public
Drop Box PublicFile1 PublicFile2 PublicFile3
Mymac:~ joan$ ls -R Public
```
Use the Command-Line Interface

`Drop Box PublicFile1 PublicFile2 PublicFile3`

`Public/Drop Box:`

`Drop Folder DroppedFile1 DroppedFile2`

`Public/Drop Box/Drop Folder:`

`DropFolderFile1 DropFolderFile2`

**Modify Files and Folders**

The `mkdir`, `touch`, `cp`, `mv`, `rm`, `rmdir`, `vi`, and `nano` commands enable you to modify files and folders.

Short for “make directory,” `mkdir` is used to create folders. The syntax is `mkdir`, followed by the paths of the folders you want to create. The `-p` option tells `mkdir` to create intermediate folders if they don't already exist in the paths you specify. In the following example, Joan uses the `mkdir` command with the `-p` option to create a folder called Private with two folders inside it called Stocks and Bonds:

```
MyMac:~ joan$ mkdir -p Private/Stocks Private/Bonds
```

Use the `touch` command to update the modification date of a specified item. The `touch` command creates an empty file if it doesn't exist.

Use the `cp` (copy) command to copy items from one place to another. The syntax is `cp`, followed by the path to the original item, ending with the destination path for the copy. If you specify a destination folder but no filename, `cp` makes a copy of the file with the same name as the original. If you specify a destination filename but not a destination folder, `cp` makes a copy in your current working folder. Unlike the Finder, the `cp` command won't warn you if your copy replaces an existing file. It deletes the existing file and replaces it with the copy you told it to create.

Use the `mv` (move) command to move items from one place to another. The syntax is `mv`, followed by the path to the original item, ending with the new destination path for the item. The `mv` command uses the same destination rules as the `cp` command.

Use the `rm` (remove) command to permanently delete items. There is no Trash in the CLI. The `rm` command removes items forever. The syntax is `rm`, followed by the paths of the items you wish to delete.

Use `rmdir` (remove directory) to permanently delete folders. The `rmdir` command removes folders forever. The syntax is `rmdir`, followed by the paths of the folders you want to delete. The `rmdir` command can remove a folder only if it's empty. You can use the `rm` command with the recursive option, `-R`, to remove a folder and all its contents.
Use the `vi` (visual) command to edit files in the CLI. `vi` is one of several built-in text editors in the CLI. Enter `vi` and the pathname to a file to edit it. macOS High Sierra redirects `vi` to a newer version, `vim`. For basic functions you probably won’t notice the difference. Like the `less` command, `vi` takes over the Terminal window with the contents of the text file. When you first open `vi`, it’s in command mode and you must type predefined characters to tell `vi` which operation you want to complete. Use the arrow keys to browse a file in command mode. Enter the letter `a` to begin editing the text. In command mode, `vi` inserts new text wherever the cursor is. Use the arrow keys to move the cursor keys. Press the Esc (Escape) key to reenter `vi` command mode. After you’re in command mode, enter `ZZ` to save changes and quit `vi`.

The text editor `nano` features a list of commonly used keyboard shortcut commands at the bottom of the screen.

**Reference 4.4**

**Manage macOS from the CLI**

In this section, you look at commands that enable you to access items normally restricted by file-system permissions.

Use the `su` (substitute user identity or super user) command to switch to another user account. Enter `su` followed by the short name of the user you want to switch to and enter the account password. The password won’t display. The command prompt changes, indicating that you have the access privileges of a different user. Enter `who -m` to verify your currently logged-in identity. You remain logged in as the substitute user until you quit Terminal or enter the `exit` command. In the following example, Joan uses the `su` command to change her shell to Johnny’s account, and then she will exit back to her account:

```
MyMac:~ joan$ who -m
joan ttys001 Aug 20 14:06
MyMac:~ joan$ su johnny
Password:
bash-3.2$ who -m
johnny ttys001 Aug 20 14:06
bash-3.2$ exit
exit
MyMac:~ joan$ who -m
joan ttys001 Aug 20 14:06
```
Use sudo
Precede a command with `sudo` (substitute user do) to tell macOS to run the command using root account access. You must have an administrator user account to use `sudo`. `sudo` works even when the root user account is disabled in the graphical interface. Be careful with `sudo` and limit access to it.

System Integrity Protection (SIP) prevents changes to parts of macOS, even for the root user. Read Reference 15.2, “System Integrity Protection,” for more information about the specific resources that are protected.

If, as an administrator user, you need to execute more than one command with root account access, you can temporarily switch the entire command-line shell to have root level access. Enter `sudo -i` and your password to switch the shell to root access. You remain logged in as the root user until you quit Terminal or enter the `exit` command.

Reference 4.5
Command-Line Tips and Tricks
Here are some command-line tips that help you customize your experience and save time:

▶ Control-click a command and choose Open man Page to read more about that command.

▶ If your Mac has a Touch Bar, type a command and press the button for that command in the Touch Bar to view the man page. The figure shows the Touch Bar displaying a button for the defaults command man page.

▶ Use Tab key completion when you enter file paths.

▶ Drag and drop files and folders from the Finder to Terminal to automatically enter their locations at the command line.

▶ Type `open .` (“open” followed by a space, followed by a period) at the prompt to open your current command-line location in the Finder.
Explore Terminal preferences (from the menu bar, choose Terminal > Preferences or press Command-Comma) to customize the look and feel of your command line.

To cancel a command or clear your current command entry, use Control-C.

You can edit commands before submitting. The Left and Right Arrow keys and the Delete key work as you would expect.

At the command prompt, use the Up Arrow and Down Arrow keys to view and reuse your command history. This includes editing old commands before rerunning them. Enter the `history` command to see your recent command history.

To clear the Terminal screen, enter the `clear` command or press Control-L.

To move the cursor to the beginning of the current line, press Control-A.

To move the cursor to the end of the current line, press Control-E.

To move the cursor forward one word, press Esc-F.

To move the cursor back one word of the line, press Esc-B.

To move the cursor to a location in a command string, Option-click where you'd like the cursor to be.

Use the inspector to view and manage running processes, and edit window titles and background colors. To open the inspector, press Command-I. To send a command to a process, select it, click the action pop-up menu, then choose a command from the Signal Process Group.

For more information about Terminal, read Terminal Help at support.apple.com/guide/terminal/welcome.

**Exercise 4.1**

**Command-Line Navigation**

**Prerequisites**

- You must have created the Local Administrator account (**Exercise 3.1, “Configure a New Mac for Exercises,”** or **Exercise 3.2, “Configure an Existing Mac for Exercises”).**
In this exercise, you use commands to navigate the file system, to view items that aren’t visible from the Finder, and to access the manual (man) pages that tell you more about commands.

**View Your Home Folder**

1. If necessary, log in as Local Administrator.

2. Click Launchpad in the Dock.

3. In the Search field at the top of the screen, enter Terminal.

4. Click Terminal.

A new Terminal window opens.

The second line you see includes your computer and user name followed by a prompt—for example:

```
Mac-17:~ ladmin$
```

In this example, Mac-17 is the name of the Mac you logged in to. The colon separates the computer name from the path to your current working directory. The path is ~ (the tilde [~] is shorthand for your home folder). After the space, you see the name of the logged-in user. The $ is the prompt.
5 At the prompt, type `ls` and press Return.

You will see output that looks something like this, followed by another prompt:

```
Desktop    Downloads    Movies    Pictures
Documents   Library     Music     Public
```

6 Switch to the Finder. If you don’t see a Finder window that’s open, go to File > New Finder Window or press Command-N.

7 Select ladmin’s home folder in the Finder sidebar and compare the contents of the home folder in the Finder and Terminal.

With the exception of the Library folder, what you see in Terminal is the same as in the Finder. (User Library folders are hidden in the Finder by default; see Reference 14.1, “Examine Hidden Items.”)

8 Switch back to Terminal and type `ls -A` (lowercase LS followed by space, a hyphen, and an uppercase A) at the prompt.

In general, the command-line environment is case-sensitive. For example, `ls -a` isn’t the same as `ls -A`.

You will see some extra files in the list that begin with a period. Files beginning with a period are hidden in directory listings unless you ask for them by entering `ls -A`. The Finder doesn’t show files beginning with a period (sometimes called dot-files).

**Examine and Change Your Current Working Directory**

Think of your current working directory as the place you are in the file system. When you open a new Terminal window, your default working directory is your home folder. Use the `cd` command to change your current working directory.

1 At the prompt, type `pwd`.

The period (.) ends the sentence and isn’t part of the command, so don’t type it. This guide tells you if a trailing “.” is part of the command. Also, press Return at the end of each step, unless otherwise instructed.

You will see:

```
/Users/ladmin
```

This is where Local Administrator’s home folder exists in the file system. It’s the folder you’re “in” in this Terminal window.
2 At the prompt, type `cd Library`.

This changes your current working directory to the Library folder inside your home folder.

This command uses a relative path. A relative path means “Start in my current working directory.”

Your prompt changes to something like this:

`Mac-17:Library ladmin$`

The path component of the prompt indicates the folder you are in, not the entire path. The `cd` command changed your working directory without providing feedback. A command that completes and doesn't need to provide feedback will exit silently. If you get an error message, you should investigate its cause before continuing.

3 At the prompt, type `pwd`.

Terminal displays:

```
/Users/ladmin/Library
```

You changed to the Library folder that was inside your previous working directory.

4 Type `ls` to view what files and folders are in this Library folder.

5 At the prompt, type `cd /Library`.

6 At the prompt, type `pwd`.

You will see output like this:

```
/Library
```

This is a different folder.

A path that starts with a leading `/` is an absolute path. It means “Start at the root folder and navigate from there.” A path that doesn't start with a leading `/` is a relative path. It means “Start in your current working directory and navigate from there.”

7 Enter `ls` to view the files and folders that are in this Library folder.

There is some overlap in the item names in this Library and the one in ladmin's home folder, but the names aren't entirely the same.

8 At the prompt, type `cd` and a space character. Don't press the Return key.

Terminal enables you to drag and drop items from the Finder to Terminal and have the path to the items appear in the command line.

In this part of the exercise, you use the Finder to locate a folder you want to use as your working directory in Terminal.
9 Switch to the Finder.

When you don't know exactly what you are looking for, it's sometimes faster and easier to find a file or folder in the Finder.

10 Open a new Finder window if necessary.

11 Click Macintosh HD in the sidebar.

12 Open the Users folder.

13 Drag and drop the Shared folder to Terminal.

   Terminal fills in the path (/Users/Shared). Macintosh HD doesn't appear in the path that Terminal fills in.
   The Finder shows you volume names to make locating a particular volume easier. Terminal doesn't show volume names in the same way.

14 Switch to Terminal and press Return.

15 Type pwd at the prompt.

   You are in the Shared folder.

**Read About ls in the Man Pages**

In Terminal, you can read the details about commands using the man command.

1 Open Terminal.

2 At the prompt, type man ls.

   This opens the man page for the ls command.
   Each man page is divided into various parts. The number in parentheses on the top line indicates in which section of the manual this command is documented. In this case, ls is documented in section 1, which is for general use commands. Next you see the name of the command and a very terse summary of what the command does: “list directory contents.” The synopsis is supposed to be a formal representation of how to use the command. Anything contained in square brackets is optional. The synopsis isn't always completely accurate. For example, a few options for ls are mutually exclusive of each other, but this synopsis does not indicate that. Generally speaking, options or switches (which change the behavior of a command) immediately follow the command, and arguments (which tell the command what to operate on) follow
options or switches. The description, which describes the various uses of the command, follows the synopsis.

3 Press the Q key to quit viewing the man page for `ls`.

4 At the prompt, type `man less`.

   The `less` option enables you to view one man page at a time.

5 Use the Space bar to read through the man pages one page at a time.

6 After you're comfortable with the `less` option, read the `ls` man page.

7 At the prompt, enter `man man`.

8 Read about the `man` command.

   You can also Control-click, or on a MacBook Pro with Touch Bar, tap the icon for a man page to open it.

Exercise 4.2
Manage Files and Folders with Commands

Prerequisites

- You must have created the Local Administrator account (Exercise 3.1, “Configure a New Mac for Exercises,” or Exercise 3.2, “Configure an Existing Mac for Exercises”).

In this exercise, you learn to copy, move, rename, and delete files and folders with commands.

Create Files

1 If you aren't logged in as Local Administrator, log in now.

2 Open TextEdit.

   TextEdit is in your Dock if you performed Exercise 3.4, “Download Participant Materials for Classroom Use.” If it isn't in your Dock, you can find it in /Applications.
3 In the TextEdit menu bar, choose Format > Make Plain Text, or press Command-Shift-T.

4 Add the following names to the yet Untitled (default) TextEdit document:

MacBook
MacBook Air
MacBook Pro
iMac
iMac Pro
Mac Pro
Mac mini
iPhone
iPad

5 From the Text Edit menu bar, choose File > Save and name the document Comps.

Leave the document in the Documents folder.
6 Close the Comps.txt document window.

7 Open a new document in TextEdit and change the format to Plain Text.

8 Save and name the new document Empty. Leave the document in the Documents folder.

9 Quit TextEdit.

**Copy and Move Files and Create a Folder**

1 Switch to or open Terminal.

2 Enter `cd` to change to the Documents folder.

3 Enter `ls` to view the files in the Documents folder.

   When you save a plain text file from TextEdit, the program adds the filename extension “.txt” to it.

4 Enter `cp` to make a copy of Comps.txt and rename it MacModels.txt.

   `Mac-17:Documents ladmin$ cp Comps.txt MacModels.txt`

   Many commands that take a source and a destination list the source first.

5 Enter `less` to view both files.

   MacModels.txt is an exact copy of Comps.txt.

   `Mac-17:Documents ladmin$ less MacModels.txt`
   `Mac-17:Documents ladmin$ less Comps.txt`

**Create a Folder and Copy a File to It**

1 Create a new folder in the Documents folder:

   `Mac-17:Documents ladmin$ mkdir AppleInfo`

   Because AppleInfo is a relative path, the folder is created in the Documents folder.

2 Enter `cp` to copy MacModels.txt into AppleInfo (don’t forget to try Tab key completion):

   `Mac-17:Documents ladmin$ cp MacModels.txt AppleInfo`
3  Enter `ls` to view the contents of AppleInfo:

```
Mac-17:Documents ladmin$ ls AppleInfo
```

**Fix a Naming Error**
The text list in MacModels.txt includes a couple of items that are not technically Mac computers. Let’s rename the file and clean up the extra copies.

1  Remove the Comps.txt file from the Documents folder and the MacModels.txt file from the AppleInfo folder:

```
Mac-17:Documents ladmin$ rm Comps.txt AppleInfo/MacModels.txt
```

You entered the command once to delete both files. The command line doesn’t have an undo function. Any change you make is permanent.

2  Move the MacModels.txt file into the AppleInfo folder using the `mv` command:

```
Mac-17:Documents ladmin$ mv MacModels.txt AppleInfo
```

3  Enter `cd` to change your working directory to AppleInfo.

4  Enter `mv` to rename the MacModels.txt file to AppleHardware.txt.

```
Mac-17:AppleInfo ladmin$ mv MacModels.txt AppleHardware.txt
```

You can move and rename a file with just `mv`:

```
$ mv MacModels.txt AppleInfo/AppleHardware.txt
```

**Remove a Folder**

1  Change your working directory back to the Documents folder. You can do so in one of three ways:

```
Use the absolute path `/Users/ladmin/Documents`.
```

```
Use the home folder shortcut `~/Documents`.
```

```
Use the relative path `..`.
```

The `..` notation refers to the parent directory of the current directory. So, because your current working directory is `/Users/ladmin/Documents/AppleInfo`, `..` refers to `/Users/ladmin/Documents`.

Occasionally, you see the `..` notation in the middle of a path instead of at the beginning—for example, `/Users/ladmin/Documents/../Desktop`. It still has the same meaning, so in this example, it refers to Local Administrator's Desktop folder.
Similarly, a single . refers to the current directory or location in the path.
Each directory actually contains a reference to both itself and its parent. These are visible if you use ls -a (note the lowercase a instead of the uppercase A you used previously).

2 Move the AppleHardware.txt file to Documents and rename it AppleHardwareInfo.txt.

Don’t press the Return key until you enter AppleHardwareInfo.txt.

Mac-17:Documents ladmin$ mv AppleInfo/AppleHardware.txt AppleHardwareInfo.txt

The path AppleHardwareInfo.txt is relative to your current working directory, so this step moves AppleInfo/AppleHardware.txt to the current working directory (Documents) and renames it AppleHardwareInfo.txt.

3 Enter rmdir to remove the AppleInfo directory:

Mac-17:Documents ladmin$ rmdir AppleInfo

rmdir succeeds because AppleInfo is empty. rmdir removes only folders that are empty. Enter rm -r to remove a folder that contains files:

Mac-17:Documents ladmin$ rm -r AppleInfo

Create and Edit a Text File
macOS includes several command-line text editors. In this exercise, you use the nano editor to create and edit a file.

1 Enter nano to create a new file named fruit.txt:

Mac-17:Documents ladmin$ nano fruit.txt
2 Enter the following words in the file on separate lines. Press Return at the end of each line.
   apple
   pineapple
   grapefruit
   pear
   banana
   blueberry
   strawberry

3 Press and hold the Control key and press and release X (Control-X) to quit nano.
   You'll see “Save modified buffer (ANSWERING ‘No’ WILL DESTROY CHANGES)?”

4 Enter Y.
   You’ll see “File Name to Write: fruit.txt.”

5 Press Return.
   nano saves your file and exits, returning you to the prompt.

6 Quit Terminal.
Lesson 5

Use macOS Recovery

One of the most useful macOS features for troubleshooting is macOS Recovery. You can use macOS Recovery to reinstall macOS and also access administration and troubleshooting utilities. macOS Recovery is on the primary system disk. This gives you easy access to recovery utilities without the need for additional media.

In this lesson, you learn how to access macOS Recovery. You also explore the utilities available from macOS Recovery. Finally, you learn how to create an external macOS install disk that you can use when local macOS Recovery isn’t available.

Reference 5.1

Start Up from macOS Recovery

Mac computers running macOS High Sierra include a hidden macOS Recovery system on the local system disk. This built-in recovery system doesn’t appear in Disk Utility or in the Finder when a Mac is running macOS.

Start macOS Recovery from the Built-In Recovery System

To start up from macOS Recovery, restart or turn on your Mac, and then immediately press and hold Command-R. Release the keys when you see the Apple logo.

After macOS Recovery fully starts, the macOS Utilities window appears. From there you can install or upgrade macOS and choose from a variety of maintenance apps.

GOALS

- Access macOS Recovery utilities
- Reinstall macOS from macOS Recovery
- Create an external macOS Recovery disk
If macOS Recovery doesn't start or isn't installed on the local system disk, you have some alternatives for accessing it.

**Start macOS Recovery from a Time Machine Disk**
The Time Machine backup service automatically creates a hidden recovery system on local backup disks. To access macOS Recovery, connect the Time Machine backup disk to your Mac, and then start up or restart while you press and hold the Option key. This opens the Mac computer's Startup Manager, where you can use the arrow and Return keys or the mouse or trackpad to select the Time Machine backup disk. *Lesson 17, “Manage Time Machine,”* covers this topic in greater detail.

**Start macOS Recovery over the Internet**
If the local built-in recovery system is missing, some Mac computers automatically attempt to access macOS Recovery over the Internet. This applies to Mac computers released in mid-2010 or later with available firmware updates installed.

macOS Recovery installs different versions of macOS depending on the key combination you use while starting up. Turn on or restart your Mac, and then immediately press and hold one of these combinations:

- Command-R—Install the latest macOS that was installed on your Mac, without upgrading to a later version.
Option-Command-R—Upgrade to the latest macOS that is compatible with your Mac. If you haven't already updated to macOS Sierra 10.12.4 or later, Option-Command-R installs the macOS that came with your Mac, or the version closest to it that is still available.

Shift-Option-Command-R—Install the macOS that came with your Mac, or the version closest to it that is still available. If you haven't already updated to macOS Sierra 10.12.4 or later, Shift-Option-Command-R is not available.

If successful, this process re-creates the local built-in recovery system. Read Apple Support article HT204904, “How to install macOS,” for more information about the differences in the key combinations.

Read Apple Support article HT201314, “About macOS Recovery” for more details about macOS Recovery.

Reference 5.2 macOS Recovery Utilities

When you start up from macOS Recovery, you can access several administration and maintenance utilities.
When you start up from macOS Recovery, Ethernet and Wi-Fi networks are available if they provide Dynamic Host Configuration Protocol (DHCP) services to automatically configure network settings. macOS automatically enables Ethernet if you connect your Mac to the network with an Ethernet cable. If you don't connect your Mac to the network with an Ethernet cable, macOS should automatically connect to a Wi-Fi network. If it doesn't, select one from the Wi-Fi menu.

From the macOS Utilities window in macOS Recovery, you can access the following functions:

- **Restore From Time Machine Backup**—Use this option to restore a full Mac Time Machine backup from either a network or a locally connected external storage device. Read Lesson 17 for more information.
- **Install macOS or Reinstall macOS**—Use this option to open the macOS Installer.
- **Get Help Online**—This option opens Safari, which takes you to the Apple Support website.
- **Disk Utility**—Use Disk Utility to manage disks, add, and manage volumes, and manage Redundant Array of Independent Disks (RAID) sets. It's useful when you start up a Mac from macOS Recovery because you can use it to manage a system disk that you can't manage when you use it as a startup disk. You can also use Disk Utility to prepare a disk for a new macOS installation or to repair a disk that fails installation. Read Lesson 11, “Manage File Systems and Storage,” for more information.
- **Startup Disk (by clicking the close button, quitting, or choosing Startup Disk from the Apple menu)**—If you attempt to quit the macOS Utilities window, you see a prompt to start the Startup Disk utility. From this utility you can select the default macOS startup disk. You can override the default startup using the startup modes discussed in Lesson 28, “Troubleshoot Startup and System Issues.”

macOS Recovery has a few extra features in the Utilities menu at the top of the screen:

![Utilities Menu](image)
Firmware Password Utility—This utility enables you to secure a Mac computer’s startup process by disabling alternate startup modes without a password. You can disable or enable this feature and define the required password. Learn more about firmware passwords in Lesson 10, “Manage Password Changes.”

Network Utility—This is the main network and Internet troubleshooting utility in macOS. Use it in macOS Recovery to troubleshoot network issues that could prevent the download of macOS installation assets. Network Utility is further discussed in Lesson 23, “Troubleshoot Network Issues.”

Terminal—This is your primary interface to the UNIX command-line environment of macOS. The most useful command you can enter from here is `resetpassword`, followed by pressing the Return key.

The `resetpassword` command enables you to reset the password of any local user account, including the root user’s, on a selected system disk. You can run `resetpassword` only from macOS Recovery. Find out more about the Reset Password assistant in Lesson 10.

**NOTE** macOS Recovery utilities can be used to compromise Mac security. Any Mac with a default startup disk that can be overridden during startup isn’t secure. Use the Firmware Password Utility to help protect your Mac computers. Read Lesson 10 for more information.

**Reference 5.3 Create a macOS Recovery Disk**

Sometimes a Mac doesn’t have a local built-in recovery system. For example, if you replace the internal disk with a new blank disk, nothing is on the new disk. Also, Mac computers on RAID sets and disks with nonstandard Boot Camp partitioning won’t have a local built-in recovery system.

macOS High Sierra includes a command-line tool, named `createinstallmedia`, in the Install macOS High Sierra app that converts a standard disk into a macOS Recovery disk. This tool copies a macOS Recovery system and the macOS installation assets to an external storage device. To use `createinstallmedia`, you must have an external storage device with at least 8 GB. Exercise 5.2, “Create a macOS Install Disk,” outlines the steps to create this disk type.
Exercise 5.1
Use macOS Recovery

Prerequisite
Your Mac must have a hidden macOS Recovery volume. This volume is created and updated by the macOS High Sierra upgrade or installation process.

In this exercise, you start up your Mac in macOS Recovery. You also review the included utilities and how macOS Recovery can reinstall macOS.

NOTE You won’t perform an installation, but you’ll get an opportunity to look at the steps leading up to the installation.

Start Up Using macOS Recovery
To access the installer and other utilities in macOS Recovery, start up from macOS Recovery.

1 If your Mac is on, shut it down by choosing Shut Down from the Apple menu.

2 Press the power button on your Mac, press and hold Command-R until the Apple logo appears on the screen, and then release the keys.

When you press and hold Command-R during startup, the Mac attempts to start up using a recovery partition on the hard disk.

If macOS Recovery isn’t available, Mac computers with newer firmware can start up from an Apple server over the Internet and get access to the macOS Recovery utilities.

If your Mac starts up to the Login Window or Setup Assistant instead of macOS Recovery, you may not have held Command-R long enough. If this happens, click the Shut Down button (at the Login Window) or press Command-Q (at the Setup Assistant) and try again.

3 If a language selection screen appears, select your preferred language and click the right-arrow button.
After macOS Recovery starts up, you see macOS Utilities. This window is the primary interface for macOS Recovery.

**Examine the macOS Recovery Utilities**

While using macOS Recovery, you have access to utilities for recovering, repairing, and reinstalling macOS. In this part of the exercise, you get to know some of these utilities.

**View macOS Recovery Help**

Use Safari to view the built-in instructions for macOS Recovery and to browse the web.

1. Select Get Help Online, and then click Continue.

   Safari opens and displays a document with information about how to use macOS Recovery.

2. Read the document.

   This document is stored in macOS Recovery, but as long as you have an Internet connection, use Safari to view online documentation such as Apple Support articles.
3 If a dialog indicates that Safari wants to use the login keychain, leave the Password field blank and click OK.

4 Click in the “Search or enter website name” field, enter apple.com, and press Return. Safari displays the Apple website.

5 If Safari displays a message saying “You are not connected to the Internet,” join a wireless network using the Wi-Fi icon near the right side of the menu bar.

6 Near the top right of the page, click the Support link (https://www.apple.com/support).
   You are taken to the Apple Support site. If you were experiencing a problem with your Mac, look for solutions and information. You use Apple Support resources later in this guide.

7 From the menu bar, choose Safari > Quit Safari (or press Command-Q) to return to the macOS Utilities screen.
   When you close Safari, you don’t quit Safari. To quit a Mac app, choose Quit App Name from the app menu (the menu next to the Apple menu, named for the current app). Or you can use Command-Q.

**Examine Disk Utility**

Disk Utility enables you to repair, image, reformat, or repartition your Mac disk.

   **NOTE** ► If your Mac startup disk is protected by FileVault, you must unlock the disk. You can use a local user password to unlock the disk.

1 Select Disk Utility, and then click Continue.
   In the device list on the left, you see your startup disk and a Base System disk image. If you are in the Show All Devices view, you see the primary entry for each disk device and an indented list of volumes on each device.
2. Select the entry for your startup volume. Typically, it is named Macintosh HD.

![Disk Utility screenshot](image)

View the buttons in the Disk Utility toolbar. These buttons represent functions that are discussed in detail in Lesson 11.

With Disk Utility you can use First Aid to verify or repair the startup volume file structure or erase the volume before you reinstall macOS High Sierra.

3. Quit Disk Utility by going to the menu bar and choosing Disk Utility > Quit Disk Utility or by pressing Command-Q.

You are returned to the macOS Utilities window.

**Examine Time Machine Restoration**

If you backed up your Mac with Time Machine, macOS Recovery can do a full system restoration from that backup. Reference 17.2, “Configure Time Machine,” covers setting up Time Machine.

1. Select Restore From Time Machine Backup, and click Continue.
Use macOS Recovery

The Restore from Time Machine screen appears, with notes on the restoration. This restoration interface erases current content and replaces it from the backup.

2 Click Continue.

The Select a Backup Source screen appears. If you configured a Time Machine backup target, it would be available here as a source for restoring macOS.

3 Click Go Back to return to the Restore from Time Machine screen.

4 Click Go Back again to return to the macOS Utilities screen.

Examine the macOS Installer
Here you examine reinstallation, but you don’t perform a reinstall. When you complete these steps, you experience the reinstallation, but you don’t have to wait while macOS is copied to your Mac.

1 Select Reinstall macOS, and click Continue.

The Installer app opens.

2 Click Continue.

3 Read the license agreement, and click Agree.

4 In the license confirmation dialog, click Agree to indicate you have read and agree to the terms of the software license agreement.

The installer displays a list of volumes where you could install or reinstall macOS.

**NOTE** Don’t click the Install button. If you do, the installer reinstall macOS.

5 Quit the installer.

Verify Your Startup Disk and Restart
The Startup Disk utility enables you to select the volume from which to start up. If you encounter problems with your internal disk during, connect a second disk, with macOS installed, and use Startup Disk to configure your Mac to start up from the new disk.
1. From the Apple menu, choose Startup Disk.

   Startup Disk lists all available startup volumes. The options might include Network Startup or one or more NetBoot images, depending on what Startup Disk finds on your network.

2. Verify that your normal startup volume (typically named Macintosh HD) is selected. If necessary, select it.

3. Click Restart.

4. In the confirmation dialog, click Restart.

   You could also restart without using the Startup Disk utility by choosing Restart from the Apple menu.

---

**Exercise 5.2**

**Create a macOS Install Disk**

**Prerequisites**

- You need an erasable external disk with a capacity of at least 12 GB.
- You must have created the Local Administrator account (Exercise 3.1, “Configure a New Mac for Exercises,” or Exercise 3.2, “Configure an Existing Mac for Exercises”).
In this exercise, you create a macOS install disk, which includes the macOS Recovery environment and tools and installation assets. When you create a macOS install disk this way, you can reinstall macOS without downloading the installer app from the App Store. Record the version of the macOS installer that you use. If you need to, you can get an updated installer from the App Store.

**Get a Copy of the Install macOS High Sierra App**

If you upgraded to High Sierra following the instructions in Exercise 2.2, “Upgrade to macOS High Sierra,” and saved a copy of the installer app, use it and skip this section.

If you perform these exercises as part of a class, the facilitator probably gave you a copy in the StudentMaterials/Lesson5 folder. Otherwise, you can download the installer using the following steps:

1. Log in as Local Administrator (password: ladminpw, or whatever you chose when you created the account).

2. From the Apple menu, choose App Store. For more about the App Store, see Lesson 18, “Install Apps.”

3. In the search field of the App Store window, enter High Sierra and press Return.

4. Find macOS High Sierra in the search results, and click the DOWNLOAD or GET button under its name.

5. If a confirmation dialog appears, click Continue.
Exercise 5.2 Create a macOS Install Disk

6 If a dialog appears asking you to sign in, either sign in to an Apple ID account or create
an App from the App Store”), for more information about using Apple IDs in the
App Store.

When the installer app finishes downloading, it opens.

7 Quit both Install macOS High Sierra and the App Store.

Reformat the External Disk
Most new external disks come preformatted with the Master Boot Record (MBR) partition
scheme. To allow a Mac to start up from MBR, reformat the disk with the GUID partition
map (GPT) scheme. For more information about disk formats, see Lesson 11.

NOTE ➤ This operation erases all content on the external disk. Don’t perform this
eexercise with a disk that contains important content.

1 Open Disk Utility. It’s in /Applications/Utilities.

2 Connect the external disk to your Mac.

3 If you are prompted for a password to unlock the disk, click Cancel.

You don’t need to unlock the disk to erase it.

4 In the toolbar, choose View > Show All Devices.

5 Select the external disk device entry in the Disk Utility sidebar. Select the device
entry, not the volume entry indented beneath it.
6 Check the partition map listed at the bottom of the window.

![Disk Utility window]

7 You might not know the partition scheme that’s currently on the disk, or the disk could include the GPT scheme. In either case, erase the disk.

You can partition the disk and use part of it for the installer volume. See Reference 11.4, “Manage File Systems,” for more information about partitioning.

8 Click the Erase button in the toolbar.

9 Give the disk a descriptive name, choose Mac OS Extended (Journaled) from the Format pop-up menu, and choose GUID Partition Map from the Scheme pop-up menu.
10 Click the Erase button.

11 When the process finishes, click Done to dismiss the erase dialog.

12 Verify that the Partition Map entry is GUID Partition Map.

<table>
<thead>
<tr>
<th>Location:</th>
<th>External</th>
<th>Capacity:</th>
<th>16.24 GB</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection:</td>
<td>USB</td>
<td>Child count:</td>
<td>2</td>
</tr>
<tr>
<td>Partition Map:</td>
<td>GUID Partition Map</td>
<td>Type:</td>
<td>Disk</td>
</tr>
<tr>
<td>S.M.A.R.T. status:</td>
<td>Not Supported</td>
<td>Device:</td>
<td>disk2</td>
</tr>
</tbody>
</table>

13 Quit Disk Utility.

Create a macOS Install Disk

1 Open Terminal.

2 Switch to the Finder, and navigate to the Install macOS High Sierra app and do one of the following:

   - If you perform this exercise in a class and the facilitator provides a copy of the installer apps, open the Lesson5 folder in StudentMaterials.
   - If you downloaded the installer app from the App Store, open the Applications folder.

3 Control-click the Install macOS High Sierra app, and choose Show Package Contents from the shortcut menu that appears.


4 In the installer package, open the Contents folder, and open the Resources folder.

5 Drag the createinstallmedia file from the Finder into Terminal.

   This inserts the full path to createinstallmedia in Terminal.

6 Switch back to Terminal, and press Return.

   This executes the createinstallmedia tool as a command-line program. It prints a usage summary and explains how to use the tool.
Enter `sudo` followed by a space to start another command, but don't press Return until step 11.

Drag `createinstallmedia` from the Finder to Terminal again.

In Terminal, enter `--volume` (enter two hyphens before `volume`) followed by a space.

Drag the MyVolume (or whatever you named it) volume icon from the desktop to Terminal.

At this point, the command should look something like this:

```
Last login: Tue Oct 24 14:06:20 on ttys000
Mac-17:~ ladmin$ sudo /Applications/Install\ macOS\ High\ Sierra.app/Contents/Resources/createinstallmedia --volume /Volumes/MyVolume
```

Switch to Terminal, and press Return.

This operation requires admin access.

Enter the Local Administrator account password (`ladminpw`, or whatever you chose when you created the account; nothing displays as you type), and press Return.

This operation erases the disk, so you are prompted to confirm the operation.

Verify that the volume name (listed after `/Volumes/`) is the one you intend to use, enter `Y`, and press Return.

Wait while the install disk is prepared. This may take several minutes, depending on the type and speed of the external disk you use.

When the process finishes, Terminal displays several lines, ending with “Copy complete.” followed by “Done.”

Quit Terminal.

**Test the macOS High Sierra Install Disk**

Test the installer disk, but don't reinstall macOS.

Go to the Apple menu and choose Restart; then click Restart in the confirmation dialog to restart your Mac.
2 Press and hold the Option key until you see a row of icons.

3 Click the install disk icon.

4 Click the arrow that appears under the icon.

   The Mac starts up in the installer environment, which is like the recovery environment. Explore it, but don’t reinstall macOS.

5 When you finish exploring the installer environment, go to the Apple menu and choose Restart to restart your Mac.
Index

Numbers
32- versus 64-bit mode, 509, 533–534
802.1X authentication, 557, 589–590

Symbols
$, using with prompts, 85
* (asterisk) wildcard, 93
\ (backslash), 88
/ (forward slash), 89
.. (parent folder), 89
.(period), appearance with filenames, 333, 455
? (question mark) wildcard, 93
>> (redirect) operator, 91
/ (root folders), 181, 355–356
[] (square brackets) wildcard, 93

A
About This Mac, 52–53, 79–81, 279–280
Accessibility settings, 213
ACEs (access control entries), 404
ACLs (access control lists), 310
Action menu, app extensions, 510
activities
searching, 56
viewing, 55
Activity Monitor
force quitting apps, 531–533
using with processes, 515–519
administrator account.
See also managed administrator user account
creating, 60–62, 822–823
resetting passwords, 243–245
using, 148–149
advanced network settings.
See also network settings
configuring 802.1X, 589–590
configuring TCP/IP, 584–586
configuring Wi-Fi, 587–588
DHCP-supplied settings, 583–584
Ethernet configuration, 592–593
NetBIOS configuration, 590
network proxies, 591
WINS (Windows Internet Naming Service), 590
AFP (Apple Filing Protocol), 658, 662–663
AirDrop file-sharing service. See also file-sharing services
discovery, 713–714
features, 711
sending items, 711–713
aliases, using with user accounts, 157
Analytics option, enabling, 45. See also Mac Analytics
Analytics privacy settings, 214
APFS (Apple File System), 5, 257–262, 376. See also file systems; volumes
app diagnostics, 540–543
app extensions
examples, 510
managing, 511–512
viewing, 511
app resources
replacing, 520
troubleshooting, 528
app standards, 4
App Store
account management, 424
Apple ID, 423–425
authentication
dialog, 424
automatic software
updates, 128–131
browsing, 417–420
buying apps, 422
copying and sharing
links, 423
details pages, 421
downloading Installer,
26
iCloud Family Sharing,
426–427
keyboard shortcuts, 418
preferences for
updates, 138
prices, 422
purchased apps, 427
Quick Links, 419
Reload Page
shortcut, 443
reviewing purchases,
443–444
Search field, 420–423
updating apps, 427
Apple Diagnostics, starting
up, 811
Apple Hardware Test,
starting up, 811
Apple ID
getting, 423–425
managing, 425–426
providing during setup,
42–43
resetting login
password, 234–235
signing in, 39–42, 426
user accounts, 156–157
using with App Store,
423–425, 436–440
Apple Pay, configuring, 48
Apple Support Tech Specs
website, 13
Apple Watch, Find My
Mac, 208
AppleDouble file format,
376–377
AppleScripts, 697
Application Support folder,
356
Applications folder,
181–182, 355
apps. See also network
apps; software updates
bundling, 132
changing default for
file type, 489–492
code signing, 428
compatibility, 22–24
dragging and dropping,
448–451
feature parity, 7
file quarantine, 428–429
force quitting, 520,
529–533
Gatekeeper, 430–432,
449–451
gathering information,
541–543
group containers, 359
installing, 433–435,
445–447
malware detection,
429–430
monitoring, 515
opening files once,
488–489
opening in 32-bit
mode, 533–534
process security, 427
as processes, 507
registration, 458
reinstalling, 453
removing, 451–453
sandbox containers,
358–359
sandboxing, 428
selecting, 440–442
System Information, 134
testing, 443
troubleshooting,
519–528
verifying compatibility,
14
Archive Utility, 345
archives, disk images,
348–349. See also file
archives; zip archives
ARD (Apple Remote
Desktop), 697, 702
ARP (Address Resolution
Protocol), 550
asterisk (*) wildcard, 93
audio devices, 749
Authenticated Ethernet,
574. See also Ethernet
authentication, 40–41, 154
Auto Save, 473–474. See
also saving documents
automatic software
updates, 138–142. See
also software updates
B
background colors,
editing, 97
background processes,
508, 535
backing up files and
folders, 14, 25. See also
Time Machine
backslash (\), 88
backup disks, 396–397
backup volume, selecting in Time Machine, 407–409
binary code, processing, 526
Bluetooth
  device management, 744–748
  features, 570, 743
  PAN (personal area network), 571–572
Bluetooth Sharing, 697
Bonjour printer, configuring, 778–784
Bonjour protocol, 641–642
bookmarks and marks, 91
Boot Camp, APFS, 262
Booster initialization stage, 796, 799
booster issues, troubleshooting, 814
BootROM firmware, 796
build number, displaying, 52
bundles versus packages, 336–337
C
  cache files, deleting, 520
  CalDAV protocol, 649–652
  Calendar and Reminders, configuring, 649–652
  CardDAV (Card Distributed Authoring and Versioning), 652–653
cat command, 91
cd command, 88, 99–101
cellular Internet
  connections, 571–572
certificates
  accepting, 559
  showing information about, 558
character strings, matching, 93
chat services, 655
Classroom server, connecting to, 69–70
CLI (command-line interface)
  accessing, 84–85
  advantages, 83–84
  customizing, 97
  editing files, 95
  erasing files, 273
  example, 86–87
  file examination commands, 91–92
  managing files and folders, 102–107
  managing macOS, 95–96
  marks and bookmarks, 91
  navigating, 87–91, 97–102
  navigating to volumes, 90
  open command, 96
  recursive commands, 93–94
special characters, 88–89
Spotlight, 92
Tab key completion, 89–90
tips, 96–97
using, 85–87
wildcard characters, 93
closed networks, 559
code signing, apps, 428
Command key. See keyboard shortcuts
commands. See also recursive commands
canceling, 97
cat, 91
cd, 99–101
cp, 94–95
createinstallmedia, 113
editing, 97
file, 91–92
find, 91–92
getting information about, 96
less, 91–92
man, 101–102
mdfind, 92
mkdir, 94–95
mv, 94–95
nano, 94–95
as processes, 507
pwd, 99–101
resetpassword, 113, 236
rm, 94–95
sending to processes, 97
su, 95
sudo, 96
touch, 94–95
vi, 94–95
comment metadata, using, 389–393
calendar account, creating, 42, 58–59
calendar name, setting, 66–67
configuration profiles
  features, 50–51
  installing, 51, 76–78
  removing, 77–78
configuring Macs, 37–38, 57. See also Macs; Setup Assistant
connections, viewing, 563–564
connectivity, monitoring, 564–566. See also network connectivity; peripheral connectivity
connectivity standards, 4
Console, using, 54–56
Contacts, configuring, 652–654
Containers and Group Containers, 356
content caching, 697
contention, managing for fast user switching, 161
Control key. See keyboard shortcuts
cookies, verifying, 217
copying
files to folders, 104–105
files to network share, 682–684
items, 94
and moving files, 104
StudentMaterials folder, 70–72
corrupted preferences, resolving, 525, 539–540
country and keyboard, selecting, 39
cp command, 94–95
CPU Time, process statistics, 516
createinstallmedia command, 113
CUPS (Common UNIX Printing System), 757–759
CUPS logs, examining, 791–792
cursor, moving, 97
D
daemons, 535. See also ubd (ubiquity daemon)
data, recovering from nonstarting system, 278–279
Davidson, Emily
creating and verifying account, 193–194
restoring account, 191–193
verifying home folder, 195
Dead End app, 448
default app, changing for file type, 489–492
deleting keychains, 237–238. See also removing
DEP (Device Enrollment Program), 146
Desktop & Documents folder, 478–481. See also documents
development standards, 4
DHCP (Dynamic Host Configuration Protocol), 39, 552–554, 573
DHCP service issues, 622
DHCP-supplied settings, confirming, 583–584, 594–595
diagnostic information configuring, 45
viewing, 54–56
diagnostic reports, 521
Dictation feature, 215–216
digital cameras, 749
directory
changing, 88, 99–101
removing, 94
disk drives, erasing, 30–32.
See also unreadable disks
disk images
archives, 348–349
creating, 347–348
mounting, 346
Disk Utility
examining storage, 266–270
First Aid, 275–276
opening, 30–31
using, 112, 116–117
viewing disk information, 281–283
disks
erasing, 271–273, 283–286
reformatting, 284–286
display. See virtual display
DNS (Domain Name System), 574, 632–633, 642
DNS resolution, testing, 623
DNS service issues, 622
Dock settings, changing, 76
document standards, 4
document storage. See
icloud Drive
documents. See also
Desktop & Documents folder; files
changing file types, 457
hiding extensions, 456
Launch Services, 458
locking and unlocking, 496–497
packages, 337
previewing, 460–462
saving, 495
searching for, 393–394
showing extensions, 457
storing in iCloud, 498–506
versions, 469–470
Documents folder,
keyboard shortcut, 390
domains for resources, 357–358
Downloads folder
closing, 74
opening, 73
drag-and-drop security, 433
dragging and dropping, 89, 96
Drop Box folder, 316
DVD or CD Sharing, 696

E
editing
commands, 97
files in CLI, 95
text files, 106–107
user accounts, 153
window titles, 97
EFI (Extensible Firmware Interface), 797
ejecting
disks, 263–264
removable media, 811
in-use volumes, 265
e-mail services, 648–649
empty disk images,
creating, 347–348
encryption. See also
FileVault
external disks, 274
FileVault, 47
Time Machine, 397–398
Energy Saver preferences, 805
erasing
disk drives, 30–32
disks, 283–286
disks and volumes, 271–273
files in CLI, 273
Macs, 29–34
startup disk, 10
error dialogs, displaying, 54
Ethernet. See also
Authenticated Ethernet
configuring manually, 592–593
connectivity issues, 619
explained, 571
hardware options, 574
Everyone permission, 309
EWS (Exchange Web Services) protocol, 649, 652
ExFAT (Extended File Allocation Table), 259
Express Set Up screen,
44, 60
extended attributes, 373–374
Extensions, 356
external disks, encrypting, 274
external user accounts, 146
F
FaceTime, configuring, 656–657
Family Sharing. See iCloud
Family Sharing
fast user switching, 160–163. See also users
FAT (File Allocation Table), 259
FAT32 volume, 376
file archives, 343–344. See also archives
file command, 91–92
file examination
commands, CLI
(command-line interface), 91–92
file flags, 373–374
file locking, 470–473
file quarantine, apps, 428–429
file resources, 355–360
file server, connecting to, 69–70
file shares, automatic connection, 666–667
File Sharing, 262, 696
file systems. See also APFS
(Apple File System)
examining storage,
266–269
formatting unreadable disks, 270–271
metadata, 373–377, 389–394
partitions, 258
paths, 87–88
permissions, 307–308
searching, 382
shortcuts, 338–343
storage and volumes, 257–258
troubleshooting, 275–279
volume formats, 258–260
file type, changing default app, 489–492
filename extensions,
showing and hiding, 455–457
files. See also documents; hidden items; locked files; text files
backing up, 14, 25
copying and moving, 104
copying to folders, 104–105
creating, 102–104
documenting, 23
editing in CLI, 95
erasing in CLI, 273
modifying, 94
naming, 105
storing in home folder, 323–324
viewing with Quick Look, 488
file-sharing services. See also AirDrop file-sharing service
automatic authentication, 660
browsing, 658–660
features, 657
manual authentication, 661–664
mounted shares, 664–666
protocols, 658
troubleshooting, 672
turning off, 687–688
turning on, 691
using, 682–687
file-system standards, 4
file-system tags, 374–375
FileVault. See also encryption; passwords
configuring recovery, 295–296
enabling, 46–47, 240, 294–298
enabling users, 296
encryption, 296–297
full-system encryption, 293
recovery, 297–298
recovery key, 299–300, 302–305
resetting passwords, 303–304
restoring passwords, 305
settings, 208
turning on, 298–300
unlocking volumes, 296
FileVault-protected Mac, 300–302
Find command, 393
find command, 91–92
Find My iPhone, 209–210
Find My Mac. See also Macs
encrypting disks, 274
Lost Mode feature, 240
using, 208–211
Finder
app extensions, 510
file locking, 471–472
Info window, 307
permissions
management, 318–319
removing apps, 453
Finder preferences, adjusting, 63–65
Finder window
ejecting disks, 263
opening, 69
Finger tool, 623
Firewall Settings, 208. See also personal firewall
FireWire, 571, 742
Firmware initialization stage
booter selection, 797–798
explained, 796–798
FileVault unlock, 798
POST (power-on self-test), 797
startup shortcuts, 798
updates, 798
firmware issues, troubleshooting, 813–814
firmware password. See also passwords
removing, 254
setting, 240, 252–253
testing, 253
Firmware Password Utility, 113
firmware updates, 15
First Aid, Disk Utility, 275–276
flash storage, See also SSD
(solid-state device), 262
folder permissions, propagating, 321–322
folders. See also parent folder; root folders;
Smart Folders
backing up, 14, 25
creating, 104
modifying, 94
removing, 105–106
revealing, 335–336
storing in home folder, 323–324
StudentMaterials, 70–72
font resources
adding for users, 365–367
confirming availability, 368
described, 356
managing, 362
removing, 363–365
testing SIP, 369–371
validating, 368–369
force quitting apps, 520, 529–533
formatting explained, 257
unreadable disks, 270–271
forward slash (/), 89
frameworks resource, 356
FTP (File Transfer Protocol) and FTPS, 658, 664
Fusion Drive, 262
Gatekeeper
apps, 430–432
settings, 208, 449–451
Get Info
accessing, 307
keyboard shortcut, 390
GPT (GUID partition table), 284
GPT scheme, 121–122
Group permission, 308–309
guest account, 149–151
GUID partition map, 121–122
H
hardware, storage, 23
hardware compatibility, checking, 22
hardware failure, identifying, 267
HDD (hard disk drive), 5, 281
help
getting online, 112
macOS Recovery, 115–116
HEVC (High Efficiency Video Coding), 5
HFS Plus, See Mac OS Extended formats
hidden items. See also files
navigating, 349–352
revealing in Finder, 334–336
viewing, 90
hidden Wi-Fi networks, joining, 559
HIDs (human input devices), 749
High Sierra. See macOS
High Sierra 10.13
home folder. See also user home folders
archiving contents, 182–183
keyboard shortcut, 349
migrating and restoring, 183–186
permissions, 314–316
storing files and folders, 323–324
viewing, 98–99
host-sharing services
connecting to virtual display, 725–727
content caching, 698–701
enabling, 693–701
network identification, 694–695
Screen Sharing, 722–725
shared services, 696–697
using, 721–727
HTTP (Hypertext Transfer Protocol), 643
HTTP server, testing for, 691
IANA (Internet Assigned Numbers Authority), 669
iCloud
Contacts, 506
saving documents, 502–503
Security Code, 239
iCloud Drive. See also storage
configuring, 500–501
enabling features, 498–500
keyboard shortcut, 506
local storage, 481–482
optimized storage, 482
removing items, 481
storing Desktop and Documents, 478–481
storing documents, 498–506
turning off features, 483–484
turning on, 475–476
using, 477–478
iCloud Family Sharing, 426–427. See also parental controls
iCloud Keychain. See also Keychain Access
authorizing devices, 206–207
resetting, 239
security code, 206
iCloud Keychain. continued

two-factor authentication, 204
using, 203–204

iCloud service
configuring, 45–46
Keychain, 43–44
using, 41

Idle Wake Ups, 517
IEEE 802.11, 571
imaging Mac disk, 116–117
IMAP (Internet Message Access Protocol), 648
iMessage service, 655
Inspector
keyboard shortcut, 325
opening, 313
viewing processes, 97
install disk
creating, 119–125
starting up from, 29–30
installation. See also reinstallation history, 134
verifying, 35–36
installation issues, troubleshooting, 20–21
installation methods, 9–10, 136–138
installed apps, viewing, 451
installed software, updating and removing, 435. See also software updates

Installer
downloading, 26
using, 118
Installer log, viewing, 35–36. See also log file
installing apps, 433–435, 445–447

configuration profiles, 51, 76–78
macOS, 15–19, 32–34, 110
software updates manually, 135–136
updates manually, 134
Internet Accounts preferences, 643–644
Internet connection type, 57
Internet Sharing, 697
invisible items, viewing, 90
IP (Internet Protocol) addresses, 548–549, 554
IP addresses, 642
IP proxies, 574
iPhones, finding, 209
IPv4 addressing, 552–553

J
Johnny Appleseed preferences, 169
user account, 171–172

K
Kernel initialization stage, 796, 800
cancellation, troubleshooting, 814–815
KEXTs (kernel extensions) approving, 218–220, 356
device driver implementation, 750–751
keyboard and country, selecting, 39, 57
keyboard shortcuts. See also startup shortcuts
App Store, 418
canceling commands, 97
clearing Terminal screen, 97
cursor movement, 97
Documents folder, 390
Find command, 393
Finder Info window, 307
Finder window, 69
Get Info, 390
Go To Folder, 335–336
home folder, 349
iCloud Drive, 506
Inspector, 313, 325
installing macOS, 110
Lock Screen, 220
Quick Look, 461
refreshing updates, 130
revealing hidden items, 335
saving documents, 495
single-user mode, 84
unmounting volumes, 263
upgrading to macOS, 111

Keychain, enabling, 42–44
Keychain Access. See also iCloud Keychain files, 199–200
managing secrets, 200–203
Safari, 202–203
using, 198
keychain files managing, 237–238
resetting, 238–239
keychains. See also login keychain; user keychains
automatic lock, 222–224
changing passwords, 237
deleting, 237–238
locking login session, 224–225
moving passwords to, 229–230
resource, 356
retrieving passwords, 226–228
storing passwords, 225–226

L
LAN traffic, 550–551
Launch Services
managing, 459–463
opening files, 458
using, 455
LaunchAgents, 357
launchd
initialization stage, 796, 800–801
user session, 803–804
launchd issues, troubleshooting, 815–816
LaunchDaemons folder, 357
Launchpad, removing apps, 435, 452
LDAP (Lightweight
Directory Access
Protocol), 652–653
less command, 91–92
Library resources, 356–357
local domain, 357
local group accounts, 152
local snapshots, restoring from, 398–399
local storage, optimizing, 485–487. See also
storage
local user account types, 147, 157–158
Location Services
enabling, 45
and privacy, 212–213
Lock Screen feature, 220–221
locked files, 470–473. See also files
locking documents, 496–497
log file, using for troubleshooting, 20–21. See also
Installer log
log messages
searching, 56
viewing, 54–56
login, configuring, 158–163
login keychain, effects of, 246–250. See also
keychains
login password, resetting, 234–235
login shell, 156
login window options, managing, 159–160
logout command
initiating, 804, 808–809
troubleshooting, 817
logs resource, 357
Lookup tool
testing DNS, 632–633
using, 623, 625–626
lost devices, looking for, 209
Lost Mode feature, Find My Mac, 240
lost passwords, resetting, 232–236. See also
passwords
LPD printer connection, configuring, 764
ls command, 88, 90

M
MAC (media access
control) address, 548
Mac Analytics, 522. See also Analytics option
Mac Integration Basics
document, 146
Mac OS Extended formats, 5, 259, 272
MacBook Pro, transferring data, 276–278
macOS High Sierra 10.13
downloading, 16–17
features, 3, 5–7
history, 7–8
managing from CLI, 95–96
standards, 4
Swift programming
language, 4
macOS Recovery. See also
Recovery
disk, 113
help, 115–116
resetpassword command, 236
resetting passwords, 241–243
starting up from, 109–113
using, 114–119
utilities, 111–113, 115–116
Macs. See also Find My Mac; Setup Assistant erasing, 29–34
getting information about, 52–53
single-user mode, 84
Mail, configuring, 42, 647–649
Mail Connection Doctor, 672
malware detection, apps, 429–430
man command, 101–102
managed administrator user account, 146. See also administrator account managed user account, 172–177
Manual (man) pages, 87, 96, 101–102
marks and bookmarks, 91
MBR (Master Boot Record), 121, 284
mdfind command, 92
MDM (mobile device management), 146, 149
memory card, verifying, 22
memory management, 508
Messages
configuring, 654–656
and Screen Sharing, 708–710
metadata, tags and comments, 389–393
Metal technology, 6
Migration Assistant, 39, 183–16
restoring with, 403–404
using, 39, 183–186
mkdir command, 94–95
model and year, displaying, 13, 53
Model Identifier, recording, 22
modem with PPP, 574
modification date, updating, 94
mounting
disk images, 346
volumes, 263–264
mouse preferences, setting, 68–69
moving items, 94
mv command, 94–95
N
nano command, 94–95
NAT (Network Address Translation), 697
NetBIOS (Network Basic Input/Output System), 574, 642
configuring, 590
NetBoot server, starting up from, 811
Netstat tool, 623
network activity
DHCP (Dynamic Host Configuration Protocol), 552–553
DNS (Domain Name System), 552
LAN traffic, 550–551
WAN traffic, 551
network apps, troubleshooting, 669–672. See also apps network attacks, 690
network connections, analyzing, 623
network connectivity. See also connectivity; peripheral connectivity monitoring, 564–566
observing problems, 629
testing, 623
testing with Ping, 630–632
troubleshooting, 627–635
network host addressing, 642
network interfaces
identifying, 570
Thunderbolt 3, 570
using, 547–548
network issues
DHCP server, 622
DNS services, 622
Ethernet connectivity, 619
isolating, 618
Wi-Fi connectivity, 619–622
network locations. See also static network location adding, 568–569
Automatic, 568–569
configuring, 568–569
DHCP-based, 595–598
features, 567
selecting, 569
Network preferences, monitoring connectivity, 565–566
network protocols, 547, 573–574
network proxies, configuring, 591
network service access, troubleshooting, 721
network service accounts, configuring, 644–647, 673–681
network service apps
  Calendar and Reminders, 649–652
  configuring Mail, 647–649
  Contacts, 652–654
  FaceTime, 656–657
  Internet Accounts preferences, 643–644
  Messages, 654–656
  Notes, 649
  Safari, 643
network service interfaces, 574–578
network service order, configuring, 601–605
network services
  Bonjour protocol, 641
  checking availability, 623
dynamic service discovery, 640–641
  gathering information from, 623
  identification, 640
  SMB (Server Message Block), 641
  software, 639–640
troubleshooting, 667–672, 687–691
network services
  communication, troubleshooting, 720
network settings. See also advanced network settings
network share
  copying files to, 685, 682–684
  mounting automatically, 685–687
network statistics, viewing, 623
network status, checking, 630
network traffic, monitoring, 634–635
network user accounts, 145–146
Network Utility
  interface information, 623–624
  Lookup tool, 625–626
  opening, 622
  Ping tool, 624–625
  Port Scan tool, 668–669
tools, 623
Traceroute tool, 626–627
troubleshooting with, 689–691
using, 113
networks. See also VNC (Virtual Network Computing)
  IP addresses, 548–549
  MAC addresses, 548
  router addresses, 549
  status indicators, 618
  subnet masks, 549
  TCP (Transmission Control Protocol), 549
  viewing connections, 563–564
  NFS (Network File System), 658, 664
No Access permission, 309
nonstarting system, recovering data from, 278–279. See also system information
Notes, configuring, 649
Notification Center, 513–514
NTFS (New Technology File System), 260
NVRAM settings, resetting, 811
online help, 112, 115–116
online stores and services, accessing, 40
open command, 96
Option key. See keyboard shortcuts
OS X versions, 8
Index

Owner permission, 308
ownership, changing for permissions, 320

P
packages, versus bundles, 336–337
pairing Bluetooth devices, 745–746
PAN (personal area network), Bluetooth, 571–572
parent folder (.), 89. See also folders
parental controls, 157–158, 172–177. See also iCloud Family Sharing; user accounts
Parker, Emily
deleting account, 190
home folder, 187–189
restoring account, 191–193
partitions, 258, 287–289, 291–292
Password Assistant, 232
passwords. See also FileVault; firmware password; lost passwords; security changing, 231–232, 237, 250–251
Keychain Access, 198
losing for administrator account, 822–823
moving to system keychain, 229–230
resetting, 241–245, 303–304
restoring, 305
retrieving from keychains, 226–228
storing in keychains, 225–226
types, 197
verifying synchronization, 251
path in file system, 87–88, 96
PDF documents, creating, 773–774, 790
period (.), appearance with filenames, 333, 455
peripheral connectivity. See also connectivity; network connectivity Bluetooth, 743
device classes, 749
device drivers, 749–750
external USB devices, 754–755
FireWire, 742
internal devices, 753–754
overview, 737–738
USB, 738–740
peripherals, Thunderbolt, 740–742
permissions
ACLs (access control lists), 310
adding, 319
examining storage, 324–328
file system, 307–308
hierarchical context, 310–313
home folder, 314–316
managing, 318–322
modifying, 321
nonsystem volumes, 322
ownership, 308–309, 320
propagating for folders, 321–322
removing, 321
securing new items, 317–318
for sharing, 313–318
standard, 309–310
testing changes, 328–331
personal firewall. See also Firewall Settings
configuring, 716–719, 727–733
enabling, 728–729
features, 715–716
testing settings, 729–731
testing stealth mode, 731–733
turning on, 716
ubd (ubiquity daemon), 729
Photo Booth Library, 337
photos, app extensions, 510
Photos Library, 337
PID (Process Identification), 517
Ping tool, 623–625, 630–632
POP (Post Office Protocol), 648
Port Scan tool, 623, 668–669, 680–681
port scans, 690–691
POSIX-style permissions, 309–310
POST (power-on self-test), 797
Power Nap feature, 806–808. See also updates
PPP (Point-to-Point) protocol, 574
Preboot volume, 260
preference files
replacing, 520
viewing and editing, 526–528
PreferencePanes resource, 357
preferences
corruption, 525, 539–540
disabling and restoring, 538–539
troubleshooting, 523–528
Preferences resource, 357
Preview app, 510–511
preview preferences, creating and locating, 535–537
print issues, troubleshooting, 777–778
print jobs
PDF documents, 773–774
starting, 769–770
print queues, managing, 788–789
print settings and presets, configuring, 771–773
printer driver, selecting, 764
printer queues, managing, 775–776
Printer Sharing, 696
printers
configuring, 759–765
device class, 749
modifying, 766–767
printing to, 785–788
sharing, 767–769
printing
CUPS (Common UNIX Printing System), 757–759
to PDF documents, 790
resetting, 792–793
troubleshooting, 791–793
Privacy Settings, 211–214
processes. See also system processes
monitoring, 515–519
types, 507–508
viewing and managing, 97
Profile Manager, 157
profiles
explained, 50
preferences, 51
prompt, using in command line, 85
property list files, editing, 527–528
protected memory, 508
pwd command, 88, 99–101
Q
question mark (?) wildcard, 93
Quick Look, previewing documents, 460–463, 488
R
-r and -R options, 93
RAID (Redundant Array of Independent Disks), 112–113, 257
Read & Write permission, 309, 311–312
read access, restricting, 317–318
Read Only permission, 309, 311–312
Recovery, starting up, 811. See also macOS Recovery
Recovery mode, repairing partitions and volumes, 291–292
recovering data, 278–279
recovery disk, starting up from, 29–30
recovery key
creating in FileVault, 299–300
resetting login password, 235
using in FileVault, 302–305
Recovery volume, 260
recursive commands, 93–94. See also commands
redirect (>>) operator, 91
reformatting disks, 284–286
Mac disk, 116–117, 121–123
reinstallation, 10–14, 118. See also installation reinstalling apps, 453
Reminders and Calendar, configuring, 649–652
Remote Apple Events, 697
remote computers. See Screen Sharing
Remote Login, 696–697
Remote Management, 697
removable media,
ejecting, 811
removing
apps, 435, 451–453
configuration profiles, 77–78
directories, 94
firmware password, 254
folders, 105–106
font resources, 363–365
installed software, 435
items from iCloud Drive, 481
keychains, 237–238
permissions, 321
renaming files, 105
repairing
Mac disk, 116–117
partitions and volumes, 286–292
repartitioning Mac disk, 116–117
reports, viewing, 55, 80, 521–523
Reset Password assistant, 236
resetpassword command, 113, 236
resource hierarchy, 357–358
restart, initiating, 809–810
restarting, 119. See also starting up
restoring
from Finder manually, 404–405
from local snapshots, 398–399
with Migration Assistant, 403–404
systems, 404
from Time Machine, 112, 402–405, 409–413
Resume feature, 473–474
rmdir command, 94–95
root account, 151–152
root folders, 181, 355–356. See also folders
root volume, navigating to, 90
router addresses, 549
routing information, viewing, 623
S
Safari
AutoFill settings, 202–203
configuring, 643
Keychain items, 202–203
privacy, 216–217
reloading current page, 635
using, 6
safe mode, using, 811–812, 816, 824–825
sandbox containers, 358–359
sandboxing apps, 428, 524
saving documents, 463–468. See also Auto Save
Scanner Sharing, 696
scanners and printers, configuring, 749, 759–769
Scheme pop-up menu, 31
screen, locking, 220–221
Screen Sharing
connecting with, 704–707
controlling Macs, 707–708
enabling, 703–704
Messages, 708–710
services, 702
using, 696, 722–725
search security, 382
searching
activities, 56
device names, 487
file systems, 382
log messages, 56
with Spotlight and Siri, 377–380
secrets, managing in
Keychain, 200–203
security. See also passwords; SIP (System Integrity Protection);
user privacy apps, 427
drag-and-drop, 433
firmware password, 240
improving for Apple ID, 40
providing for searching, 382
Security & Privacy
Advanced Settings, 208
FileVault Settings, 208
Find My Mac, 208–211
Firewall Settings, 208
Gatekeeper settings, 208
Privacy Settings, 211–214
serial number
  finding, 53
  recording, 22
server
  connecting to, 69–70
  scanning, 680–681
services and stores,
  accessing, 40
settings, documenting, 15
Setup Assistant. See also
  configuring Macs;
  Macs
Analytics, 45
Apple Pay, 48
country and keyboard,
  39
enabling Location
  Services, 45
Express Set Up, 44
Express Set Up
  screen, 60
files in iCloud, 45–46
FileVault, 46–47
network settings, 39
Sign in with Apple ID,
  42–44
Siri
  enabling, 45
  terms and conditions,
  42
Touch ID, 48
Transfer Information,
  39
user accounts, 154–155
  using, 57–62
SFTP (SSH File Transfer
  Protocol), 658
Share menu, app
  extensions, 510, 512
Shared folder, 316
shared services, 696–697,
  719–721
  sharing
  permissions for,
    313–318
  printers, 767–769
Sharing user, creating, 319.
  See also user accounts
sharing-only accounts, 151
shell, defined, 84
Shift key.
  See
  keyboard
  shortcuts
shutdown
  initiating, 804–805,
    809–810
  troubleshooting, 817
single-user mode
  starting in, 84
  startup shortcuts,
    820–821
SIP (System Integrity
  Protection), 148–149,
  361–362. See also
  security
Siri
  enabling, 45
  preferences, 387–389
  searching with, 377–379
  using, 7
sleep and standby modes,
  804–806
S.M.A.R.T. (self-
  monitoring, analysis,
  reporting technology),
  267
Smart Folders, 385. See also
  folders
SMB (Server Message
  Block), 641, 662–663
  SMB 3, 658
SMB shares
  browsing to, 682–684
  connecting to, 688
SMC (System Management
  Controller),
  resetting, 619
SMS (Short Message
  Service), 655
SMTP (Simple Mail
  Transfer Protocol), 648
software updates. See
  also apps; automatic
  software updates;
  installed software
  App Store details,
    129–131
  bundled apps, 132
  automatic behavior,
    128–129
  installing manually,
    135–138
  preferences, 132–133
space character, 88
special characters, 88–89
specifications, viewing, 24
Spotlight
  advanced search,
    382–385
  features, 7
  indexing, 380–381
  plug-ins, 381–382
  preferences, 386–387
  searching for
    documents,
      393–394
    searching with,
      377–380
  using from command
    line, 92
wildcard, 93
SSD (solid-state drive), 5, 257–259
SSED (solid-state encapsulation device), 411–412
standard user accounts
creating, 164–165
Johnny Appleseed's preferences, 169–172
logging in to, 166–169
using, 149
standards, 4
starting up. See also
restarting from disks, 29–30
from macOS Recovery, 109–113
Startup Disk
erasing, 10
using, 112
verifying, 118–119
startup modes, using, 818–819
startup shortcuts. See also
keyboard shortcuts
alternate system, 810–811
safe mode, 811–812, 824–825
single-user mode, 812, 820–821
verbose mode, 812, 819–820
startup volume, finding, 23
static network location, creating, 598–600. See also network locations
storage, examining, 266–269. See also iCloud Drive; local storage
storage devices, 749
storage information, viewing, 279–280
storage requirements, 12
storage space, reviewing, 485–487
stores and services, accessing, 40
StudentMaterials folder
copying, 70–72
downloading, 72–75
installing updates, 135–136
su command, 95
subnet masks, 549
sudo command, 96
Swift programming language, 4
system activity, viewing, 541
system domain, 357
system folders, examining, 351–352
system information. See also nonstarting system
examining, 78–81
examining storage, 269–270
inspecting, 52–56, 79–81
monitoring apps, 515
using, 22
System Information app, 134
system initialization
Booher stage, 799
Firmware stage, 796–798
Kernel stage, 800
launchd initialization stage, 800–801
stages, 796
troubleshooting, 813–816
system login window
options, managing, 159–160
system memory, 508
System Preferences
administrator account, 60–62
configuring, 63–69
turning on FileVault, 298–299
using, 598–600
system processes, viewing and using, 535. See also processes
System Reports, 522, 543
system resources
doors, 357–358
troubleshooting, 360
types, 356–357
system security. See Security & Privacy
system startup, examining, 817–818
System volume, 260
T
Tab key completion, 89–90, 96
tag metadata, using, 389–393
target disk mode
examining files, 289–291
repairing partitions and volumes, 286–291
starting up in, 811
using, 276–278
TCP (Transmission Control Protocol), 549
TCP/IP networking, 550–551, 573, 584–586
technical specifications, 13
Terminal interface
  clearing, 97
dragging and dropping to, 89, 96
using, 84, 113
terms and conditions, 58
text files, creating and editing, 106–107. See also files
TextEdit app, dragging to Dock, 75
threads, process statistics, 516
Thunderbolt, 740–742
Thunderbolt 3, 276, 570
Thunderbolt Bridge, 571
Time Machine. See also
  backing up files and folders
  backup disks, 396–397
  backup schedule, 398
  backup volume, 407–409
  backups, 398–399
  configuring, 400–401, 405–409
  encryption, 397–398
  features, 395–396
  local snapshots, 399–400
  Options, 401
  restoration, 117
  restoring from, 112, 402–405
  saving space, 401
  using to move content, 183
  using to restore, 409–413
Time Machine disk,
  starting macOS
  Recovery from, 110
time zone, setting, 45
titles. See window titles
Today view
  app extensions, 510, 513–514
  widgets, 514
Touch Bar, 96
Touch ID, configuring, 48
Traceroute tool, 623, 626–627
trackpad preferences, setting, 68–69
Transfer Information utility, 39
Trash, emptying automatically, 487
troubleshooting
  app resources, 528
  apps, 519–528
  booter issues, 814
  file systems, 275–279
  file-sharing services, 672
  firmware issues, 813–814
  installation issues, 20–21
  kernel issues, 814–815
  launchd issues, 815–816
  logout command, 817
  network apps, 669–672
  network connectivity, 627–635
  network service access, 721
  network services, 667–672
  network services communication, 720
  with Network Utility, 689–691
  peripheral issues, 748–752
  preferences, 523–528, 535–540
  print issues, 777–778
  printing, 791–793
  shared services, 719–721
  shutdown, 817
  system initialization, 813–816
  system resources, 360
  user sessions, 816–817
two-factor authentication, 40–41, 154, 204

U
ubd (ubiquity daemon), 729. See also daemons
UEFI (Unified Extensible Firmware Interface), 797
The Unarchiver app, 440–442
unreadable disks, formatting, 270–271. See also disk drives
updates. See also Power Nap feature
downloading, 136
installed software, 435
installing manually, 134
Updates list, 130. See also software updates
upgrades
  checking installation, 141–142
upgrades continued
implementing, 15–19, 25–29
keyboard shortcut, 111
preparation, 11–14, 21–25
and updates, 10
usage information, configuring, 45
USB (Universal Serial Bus), 738–740
USB adapters, 571
USB target disk mode, 276–278
user accounts. See also parental controls;
Sharing user administrators, 148–149
attributes, 155–157
configuring, 152–157
creating and editing, 153
deleting, 182–183
guests, 149–151
local group, 152
local users, 147
managed, 172–177
root, 151–152
Setup Assistant, 154–155
sharing-only, 151
standard, 163–172
standard user accounts, 149
types, 145–146, 181–182
user domain, 357
user home folders. See also home folder contents, 179
default location, 179
restoring manually, 186–195
root folder, 181
types, 180
user keychains, managing, 236–239. See also keychains
User Library folder, examining, 349–352
user login items, managing, 158–159
user privacy. See also security
Dictation feature, 215–216
Safari, 216–217
settings, 211–214
User Reports, 523
user reports, viewing, 55
user sessions
launchd, 803–804
login window, 802–803
troubleshooting, 816–817
user environment, 804
users, creating, 62. See also fast user switching
Utilities menu, 112
UUID (Universally Unique ID), 156

V
verbose mode, 812, 819–820
version number, displaying, 52, 79
version upgrades, 10
versions using with documents, 469–470
working with, 494
vi command, 94–95
video devices, 749
viewing hidden items, 90
virtual display, connecting to, 725–727
virtual network services, 572–573
VM (virtual memory) volume, 260
VNC (Virtual Network Computing), 702, 704. See also networks
volumes. See also APFS (Apple File System)
ejecting in use, 265
erasing, 271–273
explained, 257
formats, 258–260
mounting and unmounting, 263–264
navigating to, 90
permissions, 322
remounting, 264
repairing, 287–289, 291–292
unlocking with FileVault, 296
unmounting, 263
VPN settings, configuring, 578–583, 606–610
VPP (Volume Purchase Program), 128, 423
VR development features, 5–6

W
wake command, initiating, 805
WAN traffic, 551
web access, testing, 600–601
WebDAV, 652, 658, 664

websites
  Apple ID Support, 40
  Apple Support Tech Specs, 13

CUPS (Common UNIX Printing System), 758
downloading updates, 136
IANA (Internet Assigned Numbers Authority), 669
iCloud Drive, 476
iCloud service, 42
Mac Integration Basics document, 146
management technologies, 146
Profile Manager, 51, 157
UEFI (Unified Extensible Firmware Interface), 797
WEP (Wired Equivalent Privacy), 557
Whois tool, 623

widgets, managing in
  Today view, 514

Wi-Fi network, selecting, 57
Wi-Fi networks
  ad-hoc, 560
    authenticating to, 556–557
    configuring, 610–615
    configuring manually, 587–588
  connecting to, 561–564
  connectivity issues, 619–622
  joining, 559
  protocols, 574
    selecting, 555–556

Wi-Fi wireless standards, 571
wildcard characters, 93
window titles, editing, 97

WINS (Windows Internet Naming Service)
  configuring, 590
  explained, 574
  network host addressing, 642

Wireless Diagnostics, 619–622

WPA (Wi-Fi Protected Access), 557

WPA enterprise networks, authenticating to, 557–559
Write Only permission, 309

X
  Xcode, using with property list files, 527
  XML (Extensible Markup Language), 526–527
  XMPP (Extensible Messaging and Presence Protocol), 655

Y
  year and model, displaying, 13

Z
  Zeroconf standards drafts, 641
  ZIP archives. See also archives
    creating, 344–345
    expanding, 345–346
Get Apple certified.
Stand out from the crowd.

Get recognized for your expertise by earning Apple Certified Pro status.

Why become an Apple Certified Pro?

**Earn more.** Studies show that certified professionals can earn more than their noncertified peers.

**Demonstrate accomplishment.** With each certification, you get an Apple Certification logo to display on your business cards, résumé, and website. You’ll distinguish yourself from others.

**Reach a wider audience.** When you publish your certifications on the Apple Certified Professionals Registry, you can connect with even more clients, schools, and employers.

Learn the way you like.

Learn in a classroom at an Apple-authorized training location with instruction from Apple Certified Trainers.

Learn on your own with Apple Pro Training Series books from Peachpit Press.

Visit training.apple.com to learn how to get certified on these Apple products:

- macOS
- Final Cut Pro X
- Logic Pro X
- Pages
- Numbers
- Keynote

“The Apple Certification is a cornerstone of my consulting business. It guarantees to our clients the highest level of dedication and professionalism. And above all, the trusting smile of a client when you mention the Apple Certification can’t be replaced.”

—Andres Le Roux, Technology Consulting, alrx.net, inc.

Apple Training and Certification

Copyright © 2018 Apple Inc. All rights reserved.